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1. WELCOME TO POSITIVE PAY

Service Overview

Heartland Positive Pay Service is designed to empower account holders with the ability to prevent financial
loss due to check fraud. This guide is intended to provide navigational information to the Fraud Protection

and EDI Services Module within Heartland Bank’s Business Connect platform.

This guide will outline all Positive Pay functionality, but it is important to note that some features will only be
available if the feature has been enabled by Heartland Bank and you, the company user, have been
granted the appropriate user privilege required to access the feature.

The table below lists the Positive Pay types available for each account enrolled, a description of expected
behavior and protection level ranking. Positive Pay relies on enrolled Companies to make daily decisions,
when required, for the check activity that occurs on their account. When accounts are enrolled, a default
setting is established for the system to return a transaction if the user fails to do so by the established end-
of-day cut-off time. (12:00 pm noon CST) The last column in the table defines the default settings available
for each type of positive pay service.

Positive Pay
Type

Service Description

Protection
Level

Default Setting
Options

Positive Pay

This service requires the Company to provide a list of checks that
have been issued or voided on an account (Issue Items). The issue
items for each account must include, at a minimum, a check serial
number, amount, and status (issued, voided, stopped). Heartland
Bank compares each check presented for payment (Item) against the
list of issue items. If an exception is identified, designated Company
users are alerted to make a pay or return decision.

Medium

Return

Payee Positive
Pay

This is an add-on feature to Standard Positive Pay. If this feature is
utilized, Companies are required to provide the payee name for each
issue item. Heartland Bank will compare the name in the issue item
against the name that appears on the “Pay to the Order of” line of the
check presented for payment. A scoring method will be used to
determine the likelihood of a match, and if the score falls below the
established threshold, the item will be flagged as an exception. It is
important to note that payee name scoring is subject to a lot of
variables. Scoring can fail items that should pass if Companies fail to
perform best practices. Refer to the Payee Positive Pay Tips & Best
Practices Guide for more information.

High

Return

Support Multiple
Payee Names

Positive Pay can accept multiple payee names in an issued item file

and validate multiple payee names on checks presented for payment.

Multiple payee names can be placed on a single line or multiple lines.

High

Return

Reverse Positive
Pay

This service does NOT require Companies to provide a list of issued
items. Companies will need to login every day to view checks
presented for payment and select the checks they want to return
because the concept of an exception does not exist since there is no
list of issue items to compare items against. However, Companies
may request Heartland Bank establish a maximum check amount per
account (Exception Limit). If this optional setting is enabled, an alert
will be sent to designated Company users ONLY when a check is
presented that exceeds the maximum amount established.

Low

Pay




1. Positive Pay offers alert notifications to call designated Company users to action when required. Positive
Pay is designed to ensure notifications are relevant, but each Company can advise Heartland Bank of
notification levels that best suit their needs. Email alerts are standard. Companies can receive text alerts if
enabled for a user.

2. The table below outlines a list of events that trigger an alert to a Company user, a description of the
triggering event and if the alert type is Standard or Optional.

Standard or

Alert Type Description Optional
Occurs when a check is presented for payment that does not match the
Exception Alert issue information provided or if an exception limit is set on an account Standard
enrolled in Reverse Positive Pay.
Issuance File Load Occurs when an issue file is loaded. The alert contains status
Alert information to indicate if the issue item loaded properly or if the issue Optional
item failed due to errors.
Issue File Pending Occurs when an issue file has been loaded and is being held in .
» 7 ] Optional
Approval Suspended” status until approved by a secondary user.
Decision Approval Occurs when check transaction decisions require a secondary approval. Optional

Required

3. When an account is enrolled with Positive Pay, notifications are established for exception alerts. The
notification, description and a sample email are provided in the table below. SMS text options are also

available.

Notification
Level

Description

Service Alerts

One alert per Company when one or more exceptions are identified on one or more accounts.



4. Sample Alert Via Email:

Heartland Positive Pay Alert

o HET@hithankeom

Transactions for Haartland Positive Pay are available to dacision.

sinceraly,
Heartland Bank and Trust Cormpany

Contact Us
Please do not reply tothic email. If you have questions abaut your account, please call Custonmer Service at (855) 244-1215 or email us at BusinessConnect@hbtbankonm

Heartland Bank and Trust Company
401 Marth Hershay fd
Bloomington, IL 61704

2. ACCESSING POSITIVE PAY

1.

To access Check Positive Pay, select the Commercial Tab in Business Connect, then select the
Fraud Protection and EDI Services or Fraud Protection Services option.

Heartland ® - -
Bank @i

Dashboard Accounts Transfers eStatements Commercial Settings Support
Commercial
Dashboard ‘ @ ‘ ‘ 5 ‘
ACH Fraud Protection and EDI
Services
Wires
- Business Admin e
N You have 1 pending external accoun Remote Deposit
@ Confirm trial deposits to finish linking external & Autobooks
Reports te(s) ~
Lockbox
Accept Payments *7 11 wansrers $14.75 v

E B8

Send an Invoice Accept Payments Now

e
Accounts @ .

Link External Accounts




2. Select the green Submit button to enter Check Positive Pay Services.

i =

Company

Dashboard Accounts Transfers Bill Pay eStatements Commercial Settings Support

Positive Pay and ACH Reporting e o

(=)

Using the Dashboard

1. The Dashboard is the default landing page within the Fraud Protection and EDI Services portal. If Positive Pay
is enabled, the Heartland Positive Pay option will be displayed. Summary information on current check
transactions and the decision status will be displayed for accounts the user has been granted access. Active
links are embedded to permit users to navigate from the dashboard landing page into the Positive Pay service
module or directly to transactions in the status selected. Dashboard totals are updated in real time as
transaction status values are changed by a user.

The content displayed in the Positive Pay summary box includes the following:

Heartland Positive Pay

End of Day Cut-Off Time: Thursday 12:00 PM CST
Exceptions $64,009.42 [10]

Set ta Pay $348,850.53 [43] Set to Return $0.00 (0]




Service Name In the example above, selecting Heartland Positive Pay in the service
module title bar will direct the user to the check positive pay module
landing dashboard

End of Day Cut-Off Time  Displayed in the second bar, the end of day cut-off time indicates when
transactions requiring decisions will no longer be eligible for user
decisions. Heartland Bank’s end of day cut-off time is 12:00 PM NOON
CST.

Exceptions Selecting the dollar amount hyperlink on the Exceptions line will direct
the user to a filtered view of the transaction history displaying only the
exceptions requiring a decision.

Pending Approval If Dual Decision Approval has been enabled, the Pending Approval
hyperlink will appear in the Dashboard. Selecting the dollar amount
hyperlink on the Pending Approval line will direct the user to the Check
Transaction Approval screen where the user can approve or reject any
transactions pending approval.

Heartland Positive Pay

End of Day Cut-Off Time: Thursday 12:00 PM CST

Exceptions $64,009.42 [ 10]

Set to Pay $348,850.53 [ 43] Set to Return $0.00 [0]

Set to Pay / Set to Return  Clicking on the dollar amount hyperlinks on the Set to Pay or Set to
Return lines will expand the view to display a breakdown of the total for
each category.

Date Range
Transaction History B Dec 73, 2035 -
Mass Pay & Issue Payee Review (0]
T Filters >
1 %
[
Transaction ID Account Number Serial Number Cradit Dabit Datﬂll Decision Exception
C - 21 74E6 k P I
3 1338852 W77 21748 £432.11 127232025 Pay RtiET s
> 133EESY WA TITT 217485 S500.00 1272302025 Pay Return $
>  133EESD M TITT 217484 $65.55 127332025 Pay ReTUn £

Transaction History = The user can select the dollar amount hyperlink for any category to be
directed to a filtered view of the Transaction History. In the above example,
the user has selected the dollar value of the Exceptions from the Dashboard.
The user is then directed to a view of exception items requiring a decision.




2. From the Dashboard, a user can navigate to the Positive Pay Module by clicking Change Module > Heartland
Positive Pay.

B

FI Management £ Manage ~ diReports - i Security ~ iE View ~ {& Warehouse View Change Module

Heartland Positive Pay

Heartland Credit ACH Filter
EDI TransAlert
< Change Client Heartland Debit ACH Filter

Please select an existing user or create a new one.
Create Client User

3. MANAGING ISSUED ITEMS

Positive Pay services require Companies to maintain a list of issued items for Heartland Bank to compare
presented items against so exceptions can be identified.

While issue items can be added after a check has been presented for payment, it is highly recommended
Companies enter or load issue items prior to disbursing paper checks to payees, as failure to do so could
result in denial of payment if the check is presented at the teller line for deposit or to be cashed.

When an issued item is entered or loaded into Positive Pay, the status and disposition of the issued item is
tracked. The list below describes the status and disposition labels associated with issue items.

Status Values

o Issued — A status defined by the Company that indicates a check was issued. The check has been
issued and distributed for payment.

¢ Voided — A status defined by a Company that a check was issued but later voided and not distributed.
The check has been voided by the maker. A check is usually voided prior to disbursement. A voided
check cannot be used to make a payment or withdraw money from the account.

o Stopped — A status defined by a Company that indicates a check has been stopped. A check that has
a stop payment placed on it. A stop payment is placed with Heartland Bank to cancel a check that has
not yet been processed.

e Cancelled — A status defined by a Company that indicates an issued check is to be cancelled and
removed from the outstanding issue items in the Issue Warehouse. A check that has been issued and a
company user has opted to cancel the item. The outstanding issue item will be removed from the Issue
Warehouse.

e Available for Matching — A status assigned by the Positive Pay system when an issue item is entered
or loaded by a Company.



e Used in Matching — A status assigned by the Positive Pay system when a check is presented for
payment with a serial number that matches a serial number for an issued item.

¢ Qutstanding — A status displayed in the issue warehouse that indicates a check has not yet been
presented for the issued item and it is still available for matching.

o Paid — A status displayed in the issue warehouse that indicates a check has been presented against an
issue item and it was paid by the system or Company user.

o Returned — A status displayed in the issue warehouse that indicates a check has been presented
against an issue item and it was returned by the system or Company user.

e Purged — A status assigned by the Positive Pay system when an issue item that has not been used in
Matching (outstanding) has been removed from the system. The purge period is defined by Heartland
Bank.

o Deleted — A status value displayed in Issue File Status that indicates a file that was loaded was deleted
by a Company. A history of the file load and delete action are retained but the issue items are removed
as if they were never introduced to the system.

e Updated — If an issue item is updated after it was loaded, history will be available in the issue item
warehouse when the drop-down for an issue item is expanded.

Manual Entry

Companies can manually enter a list of checks that have been issued. To manually enter an issue item, the
user must be granted the manual issue entry user privilege.

1. From the Heartland Positive Pay module, click Perform > Manual Issue Entry.

I
o
q

Heartland Positive Pay ~ % Manage - = # Perform ~ = JiReports ~

Issue File Load

Manual Issue Entry
Paid Mo Issue Match '] e

Please use the above menu to select an action




2. The Manual Issue Entry screen appears.

Manual Issue Entry

Account? Auto populate next check number; (]

- not selected - v

Row Check Number Amount Payee Name’ Status Issuance Date

ISSUED v 10/12/2022

@ Click any row to select that row for editing

Save

Account Select the appropriate Account Number from the drop-down menu.

Auto populate next When checked, the next check number will auto-populate in the following row. This feature is
check number designed to eliminate serial number entry when checks are issued in sequential order.

When unchecked, the next check number will remain blank until it is filled in by the user.

Row Each issue item will be numbered in the order they are entered. Once the cursor is placed in the
current row, an additional row will appear for the next entry.

Serial Number Type the item serial number for this manual issuance file in the Serial Number field.

Amount Type the dollar amount for this manual issuance file in the Amount field. Or use the up and
down arrows in the Amount field to select a dollar amount.

Payee Name Type the payee name for this manual issuance file in the Payee Name field. The Payee Name
field supports the entry of a single payee, or multiple payees.

Status Issued The check has been issued.
Voided The check has been voided by the maker.

Issuance Date Click on the Issuance Date field and select a date from the calendar that this item was issued. It

is important to note that on accounts configured for Active Account Reconciliation, the Manual
Issue Entry screen will not permit selecting a date prior to the start date of the current
reconciliation period.

10



3. Payee Names: The Payee Name field supports up to four Payees.

a. Click within the Payee name field to enter Payee Name(s).

Row Serial Number Amount Payee Name’ Status Issuance Date

10100 300.00 ISSUED v & 03/03/2021

b. The view size on the Payee Name field can be enlarged by dragging bottom right corner of field box.
The feature may not be available based upon the browser used.

c. Input the Payee Name in the field. If there are multiple payees, an Enter (carriage return) must be
used to input a second, third or fourth payee on separate lines in the field for it to be distinguished as
different payees.

Row Serial Number Amount Payee Name’ Status Issuance Date
4 10100 300.00 Helen Jones ISSUED ot = 03/03/2021
Michael Jackson
Francine Doe -
Lisa Miller y

If multiple payees are listed on a single line of the check, putting them on separate lines is not applicable.

d. The Payee Name field currently supports 500 characters in total. This count will include the carriage

returns separating multiple payees. The 500-character limit is for the entire field, and not per payee.

Row Serial Number Amount Payee Name’ Status Issuance Date

10100 300.00 Helen Jones & Lisa I\"Hlled ISSUED v == | 03/03/2021

It is important to note that although 500 characters are allowed in this field, names might be truncated if
using a fixed width template and the number of characters allowed in that column are less than 500.

e. If Payee Positive Pay is enabled, the Payee Name field will not accept blank entries for items with
Issued status and will give an error message if an entry is attempted to be saved without a Payee
Name.

Payee Name is required unless status is VOIDED.

4. To edit any row, click in the fields to be edited and make changes.
5. When all manual issuance files have been entered, click the Save button.

11



6. The Manual Issuance File Status detail page appears.
7. Click the Back to Status button to view the Issuance File Status page.

8. Issuance Dual Approval:

< Back to Status MANUAL_1614874619362

File Status

Queued Processed Approved / Rejected Completed Deleted

Some items are ineligible. View list below to see items. Remove ineligible items and reload file

@ View items: 3 Items totaling $1,375.00 Load Date: 03/04/2021 11:16:59 EST
Rows 1-3of 3.
Account Number Serial Number Amount Payee Name Status Issuance Date
w3232 100945 $525.00 Moe Green INELIGIBLE_FOR_MODIFICATION 03/04/2021
03232 100946 $500.00 River Rouge INELIGIELE_FOR_MODIFICATION 03/04/2021
w3232 100949 $350.00 Margaret Anjou INELIGIBLE_FOR_MODIFICATION 03/04/2021

Some companies may have the optional Issuance Dual Approval feature enabled. In this circumstance,
manual entry files must be approved by a second user.

Issue Templates

The purpose of issue templates is to make it easy to load issue items into Positive Pay using files that can be
generated out of most accounting systems. Positive Pay provides Companies a variety of flexible options for
providing a list of checks that have been issued or voided.

Issue templates allow users to select from a list of file formats supported and identify where the required data
elements are located within the file.

Once a template has been set up, the template can be selected when loading a file to tell Positive Pay how to
utilize the data contained in the file.

Multiple file templates can be set up, displayed and used. Companies are allowed to create their own
templates.

NOTE: The Issue Template user privilege must be enabled.

12



1. From within the Positive Pay module, click Manage > Issue Templates.

Heartland Positive Pay & Manage - # Perform - i Reports ~ = View ~

Issue Templates

Welcome

Please use the above menu to select an action

2. Ascreen will appear listing any existing templates available to view or edit, and a button to Create New
Template. Templates created by the Company can be modified by the Company.

e

Template File Type
2011 Regression C Comma Separated @
Csv Comma Separated @
S Comma Separated @
DBFI Fixed Width Fixed Width @
Excel 1 Excel Workbook @
Excel 97-2003 Workbook ]
Quickbooks Type 1 Excel Workbook @

[m] 2008 Regression Comma Separated e

[m] 2008 Regression A Excel Workbook e

3. To view or edit an existing template, click the pencil icon for the appropriate template. The template will
display with the date the template was last updated.

X
Edit Template: 2105 Template C Last Updated: 12/13/2021
Template Name File Type’ Template Status

2105 Template C Excel Workbook w Active o

4. To delete an existing template, click the checkbox next to the Templates to be deleted and click Delete
Selected. Templates that have the Delete option were built by the Company and can be deleted/edited
by the Company user.

5. To create a new template, click the Create New Template button.



The upper portion of the template screen will not change, regardless of the file type selected. The template
name, file type and template status values are required. The header and footer fields are optional.

Many accounting systems can export excel or fixed width files. Sometimes those files have header
(beginning) rows or footer (ending) rows that contain data that is not required by Positive Pay.

When setting up a template, the Company can define the number of rows Positive Pay should ignore at the
beginning and end of the file. It is important to note that if the values are entered incorrectly, an issue file
may load with errors or no items.

The mapping section below will display based on the file type selected. Excel and separated value files will
require Companies to define the column where data elements will be found.

Create New Template

Template Mame File Type’ Template 5tatus
- select file type e Active b

Number of Header Rows’ Number of Footer rows’ Template Level
0 o Client b

Multi-Line Payee Name Separator: ?

Do not use a character as a separator if
that character will ever be presentin a
Payee Name. Allowed characters in
brackets[; | ,-_/]

This Client has not been setup for client additional issue fields in templates.

Configure in Client le

vel settings and setup client additional issue fields for the Client and try again.
File Mapping
Add Input Field’ File Column’® Field Format
Serial Number
Amount’ ® Fractional Dollars (12.34)
Whaole numbers of cents (1234)
= Status’ ISSUED - for ISSUED
- for PP )
STOPPED or STOPPED
e - for VOIDED
VOIDED !
O Account Number’
[ Issuance Date’
= Fayes Mame’
O Routing Mumber?
o Place the cursor over this label for more information

14



Fixed Width files will require the Company to define the start and end position in which the data
element is located.

Create New Temp late

Template Name File Type’ Template Status
Fixed Width hd Active b

Number of Header Rows’ Number of Footer rows’ Template Level’
0 0 Client b

Multi-Line Payee Name Separator: 7

Do not use a character as a separator if
that character will ever be pres
Payee Name.

owed characters in
brackets[: | .- _/]

This Client has not been setup for client additional issue fields in templates.

Configure in Client level settings and setup client additional issue fields for the Client and try again.

Add  Input Field’ Start Position’ End Position’ Field Format
Serial Number

Amount’ ® Fractional Dollars (12.34)

() Whole numbers of cents (1234)

/] Status’ [SSUED - for ISSUED
STOPPED - for STOPPED
R - for VOIDED
[ Account Mumber’

Issuance Date’

Payes Name’

Routing Number’

’_ Place the cursor over this label for more information
e Place the cursor over this label for mo at

The mapping section on the lower part of the screen displays the required fields. The Check Serial
# and Amount fields are always required. The Company must specify if the amount data in the file
to be imported will or will not contain decimal points. For example, if the Amount value is set to
Fractional Dollars, then 100, 100.0 and 100.00 are all processed the same. If the Amount value is
set to Whole numbers of cents, the system will divide by 100 and save it as a dollar value. For
example, a value of 100 would be saved as $1.00 in the system.

The Company may choose to import additional data by checking the Add box next to the desired data
element.



If the Status box is not checked (as shown below), Positive Pay will load all issue items with a status of
Issued. If the Company file represents Voided items as a negative number, the Company can check the
box “Treat Negative Amount as Void” and Positive Pay will status any item in the file with a negative value
as Voided. Issuance with a $0 amount will also be treated as void.

Create New Template

Template Mame File Type’ Template Status
- select file type - Active e

Number of Header Rows’ Number of Footer rows’ Template Level®
0 o Client i

Multi-Line Payee Name Separator: ¥

Do not use a character as a separator if
that character will ever be presentina
Payee Mame. Allowed characters in
brackets [ : f 1

File Mapping
Add Input Field? File Column® Field Format

Serial Number

Amount? @ Fractional Dollars (12.34)
O Whole numbers of cents (1234)
O Status’ Treat Negative Amount As Vaid®

Issuance with $0 amount will be treated as Void

Create New Template

Template Name File Type’ Template Status
| Fixed Width v| Active v

Number of Header Rows’ Number of Footer rows’ Template Level’
Q 0 Client A4

Multi-Line Payee Name Separator:

Da not use a character as a separator if
that character will ever be presentin a
Payee Name. Allowed characters in
brackes[; ] .-_/1]

File Mapping
Add  Input Field’ Start Position’ End Position’ Field Format

Serial Mumber

Amount? @® Fractional Dallars (12.34)
(O Whaole numbers of cents (1234)
] Status’ Treat Negative Amount As Void?

Issuance with $0 amount will be treated as Void




If the Company checks the Status box additional fields will display as shown below. If the Company’s
accounting system exports issue items with an Issued and Voided status, no additional action is required.

Status’ ISSUED - for ISSUED
STOPPED -for STOPPED
VOIDED - for VOIDED

It is important to note that if the Status box is checked for a template, and this information is not provided in
the issue file loaded, the system will give each record an ISSUED status.

If the accounting system used exports issued items with a value of X and voided items with a value of Y,
the user can identify the values as shown below so Positive Pay can translate the data appropriately when
importing the data.

Status’ X - for ISSUED
- for STOPPED
¥ - for VOIDED

A description has been provided below to define system behavior if additional data elements are included.

Account # If the account box is selected, the user can import one file that contains issue items for multiple
accounts. If the account box is NOT selected, when a Company user loads a file through the
Company portal, Positive Pay will require the user to select the account the checks were issued
on.

Issuance Date If the issuance date box is NOT checked, Positive Pay will default the issue date to date the file
was loaded. If the issuance date box is checked, the file must contain an issuance date for each
item. For Excel files, Positive Pay will translate the data format used in the file. For separated and
fixed width files, the Company must define the date format being used as shown in the
screenshot below. It is important to note that the formats displayed are examples only, a
complete list of date formats can be found at:

https://docs.oracle.com/javase/8/docs/api/java/time/format/Date TimeFormatter.html#patterns

The Payee Name box will only appear if one or more accounts are configured for payee positive
pay. If the payee name box is checked, Positive Pay will require the payee name for accounts
configured for payee positive pay. If payee name is provided for accounts not enrolled in payee
positive pay, the payee name data will be ignored when the file is loaded. For Excel or delimited
files, the complete and single payee name is expected in a single column. For fixed width files,
the complete and single payee name must be contained in the file between the starting and
ending position.

Payee Name

It is important to note that when a payee name is required in an issuance file, values
consisting of only white space (i.e., all spaces) will be considered the same as an empty
value and will not be accepted.

17


https://docs.oracle.com/javase/8/docs/api/java/time/format/DateTimeFormatter.html#patterns

Issuance Date’

M for menth, d for day of month, y for year
Examples:

yyyy-MM-dd for 2019-12-25

MM/ dddyy for 12/25/19

MMM dd, yyyy for Dec 25, 2019

Loading Issue Files

NOTE:

» The Load Issuance File user privilege must be enabled.

> If Multiple Payee Names feature is enabled, Positive Pay will support more than one payee
name in the Payee Name field of issuance files.

> If Payee Name is a required field in the issuance template used, it is important to note that
issuance files in which the payee name field contains values consisting only of white space
(ex, all spaces) will be considered the same as an empty value and will not be accepted.

» Issue file loading will strip and ignore dollar signs on dollar amounts, and double and single
quotations around data fields.

> For best results, users should not load issue files with mixed account numbers unless they
have access to all the listed accounts. Loading issue files with account numbers for which the
user has no access will cause errors.

» There is a 100-character limit on issuance file names.

Positive Pay allows Company users to load issue files into the system for use in matching. Positive Pay accepts
these files in a variety of formats, used in conjunction with file templates (covered in the previous subsection).

6. From the Portal:
a. Heartland Positive Pay module, click Perform > Issue File Load.

][]
]
1

Heartland Positive Pay ~ #Manage ~ | # Perform ~  JliReports ~

Issue File Load
Manual Issue Entry
Paid No Issue Match “I e'

Please use the above menu to select an action




b. The Load Check Issuance File page appears.

Issue File Load

Template to Use With Issue File

- select template - v Create New Template

Select template that matches issue file format

c. Select the Template drop-down box to select from a list of existing templates. Select one of the
available templates listed. If only one template is available, the drop-down box will select that
template by default.

Issue File Load

Template to Use With Issue File

- select template - v Create New Template

- select template -

1234

csv

DEFI Fixed Width

Excel 97-2003 Workbook
Excel Workbook 2
TestTemplated
tester

d. If the template selected was created without the Account field enabled, then a drop-down box will
display so an Account can be selected. Select from the list of accounts. If only one account is
available, the drop-down box will select that account by default.

Issue File Load

Template to Use With Issue File Account?

Excel Workbook 2 w - not selected - w Create New Template

- not selected -

FFF Escrow - xood444
FFF Expense - xxxx3333
FFF Payroll - xxxx2222
Select account and template that matches issue file format| FFFriends - xoo0c1 111

View Selected Template
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e. The file upload interface will appear. Click the Browse button to select the appropriate file.

Issue File Load

Template to Use With Issue File Account”
Create Mew Template

Excel Workbook 2 ~ FFFriends - xoox1111

View Selected Template

Select one issue file that is in the format of the selected template

Select files...

Once the file is selected, it will be displayed in the upload interface.

Issue File Load

Template to Use With Issue File Account’
Create New Template

Excel Workbook 2 v FFFriends - xoomx1111 v

View Selected Template

Select one issue file that is in the format of the selected template

A

B Issue 0529-001.xIsx

I Remove = @ Upload

The file will be removed from the page.

Remove
Browse Use Browse to locate the file you want to load.
Upload The file will be uploaded.
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f. The Status Bar will display the current status of the file.

= Back to Status WEKP1 Issue 1028-001.xlsx

File Status

Queued Processed Approved / Rejected Completed Deleted

File is processing .. .

g. If errors were encountered during the initial processing of the issuance file, the Parse Errors display
will appear, allowing the user to view the error detail within the file. The most common reason this
error would appear is because the file contains improper formatting. At this point, the user will have
the option to:

> Correct those errors.

» Delete individual errors. This feature only displays if there are errors in the file and is only
available until errors have been corrected and the file is saved.

» Delete all errors. This feature only displays if there are errors in the file and is only available until
errors have been corrected and the file is saved.

o This will retain the totals and counts for audit history.
» Discard the file. This feature shows up when there is an error in the file. This option is not

available after corrections have been made and saved. This will remove the file and its
contents from the system.

< Back to Status ASBC1 Issue 0415-004.xlsx
File Status

Queued Processed Approved / Rejected Completed Deleted
errors occurred during loading. View list below to edit errors. If errors remain after 04/21/21, the issuance file will be automatically discarded.

@ Edit 4 Errors

Rows 1-4of4.

Line
Number Account Serial Number Amount Payee Name’ Status Issuance Date Delete
7 21111 11568 $30.00 Richard Canova ISSUED 04/15/2021 L]
6 z1111 11567 $260.00 Office Pride ISSUED 04r15/2021 o
5 21111 11566 $600.00 Jonathan Copeland ISSUED 0471572021 L]
Michael Copeland
a 21111 11565 $65.55 Cisco Webex, LLC ISSUED 04r15/2021 o

& Click any row to select that row for editing

Discard File Save

In this case, the account numbers in the issuance file were entered incorrectly and they need to be
corrected before the file can be fully processed and loaded.



h. Click on any of the fields highlighted in red to make updates or changes.

® Edit 4 Errors
Rows 1 -4 of 4.
Line
Number Account Serial Number Amount Payee Name’
z1111 11568 30 Richard Canova

- select accounr v 11568 $ | 30 .

7 L] Richard Canova
- select account - p
OctaTest - xxxx8888
The One and Only - xxxx1111

6 11567 $260.00 Office Pride

PC Test - 001369

Gilbert's Grapes - xxxx6732

Status

ISSUED
ISSUED

ISSUED

Issuance Date Delete
2021-04-15
= 04/15/2021 =
m
04/15/2021 ]

In this example, the user is presented with an account number drop-down so they can choose the
correct account number for the issuance item.

i. Once all errors have been corrected, the red highlights are no longer visible, and the file can be
reprocessed by clicking the Save and Submit button. This feature is only available until all errors are

corrected, deleted, or discarded.

@ Edit 4 Errors
Line
Number Account Serial Number
7 The One and Only 11568
-600061111
& =t +H567
5 The One and Only 11566
-xoocl 111
4 The One and Only 11565
-w000e1111
@ Click any row to select that row for editing
Discard File

Rows 1 -4 of 4.

Amount Payee Name’
$30.00 Richard Canova
S260-66 EfficePride
$600.00 Jonathan Copeland
Michael Copeland
$65.55 Cisco Webex, LLC

Status

ISSUED

ISSUED

ISSUED

Issuance Date Delete
04/15/2021 i}
BehitEizaa g
04/15/2021 L]
04/15/2021 i

|

Save and Submit

j-  The file will be returned to processing.

< Back to Status

File Status

Queued Processed

File is processing . . .

PGO1 Issue 0303-002.xIsx

Completed

Deleted
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k. If the file processes successfully, the user will be able to view the details on all the items in the file.

< Back to Status PGO1 Issue 0303-002.xlsx

File Status

Queusd Processed Approved Completed Deleted
ile processing is complete. Vier belw ee item
@ View items: 15 Items totaling $12,246.81 Load Date: 03/03/2021 15:07:38 EST

Rows 1-150f 15.

Account Number Serial Number Amount Payee Name Status Issuance Date
003783 2665 £65.55 Cisco Webex, LLE NEW _ISSUANCE_ITEM 03/03/2021
ax3TES 2668 £600.00 Jonathan Copeland NEW _ISSUANCE_ITEM 03/03/2021

Michzel Copeland

wooo37E3 2667 $260.00 Office Pride NEW_ISSUANCE_ITEM 03/03/2021
w3783 2668 £75.00 Richard Canova NEW_ISSUANCE_TTEM 03/03/2021
Aaxn3TEI 2669 £5233.00 VWaller Lansden Dortch & Davis, LLF MNEW _ISSUANCE_ITEM 0310372021
*xux3783 2670 £24.00  Advancsd Madica NEW_ISSUANCE_ITEM 03/03/2021
woox37E3 2671 £6.130.00 Citizens Union Bank NEW_ISSUANCE_ITEM 03/03/2021
w3783 2672 £53.36 Cowey Saminars NEW_ISSUANCE_ITEM 03/03/2021
xx3TE3 2673 19353 Cuyahoga County Clerk NEW_ISSUANCE_ITEM 03/03/2021
a0ex3TE 2674 £2,800.00 Michael Farre NEW_ISSUANCE_ITEM 03/03/2021
Aix3TES 2675 $150.00 Mesta Archeron NEW_ISSUANCE_ITEM 03/03/2021

Elain Archeron

ax3TES 2678 £150.00 Jake Chambers NEW _ISSUANCE_ITEM 03/03/2021
Xx37TE3 2677 $750.00 ABC Carpentry NEW_ISSUANCE_ITEM 03/03/2021
wono37E3 2678 £35.00  Office Pride NEW_ISSUANCE_TTEM 0370342021
wox37E3 2679 $26.97 FedEx NEW_ISSUANCE_ITEM 037032021
Delete

If there are no errors in the file during the initial load, then the file will automatically display as
approved and complete.

If an issuance file needs to be deleted for any reason, the user can click on the Delete button and the file will
be removed. Deleting a file will retain item counts and totals as audit history. NOTE: Files are only eligible
for deletion if every item in the file is still in an available for matching status. If just one item in the file
has been paid, the file cannot be deleted.
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: Date Range
Issuance Files Status T s
EFebruary 28, 2020~
Y Filters >
549.84

Issuance Load File Load ; : Transaction Transaction

ID ID File Name Status Status Message Date/Timel: Count Total View/Manage

4123 2418 (W Issue DELETED Deleted By Client 02/28/2020 14:23:52 ) 5b,354.64 i
0228_3.csv User EST et

7. Issuance Dual Approval:

Some companies may have the optional Issuance Dual Approval feature enabled. In this circumstance,
loaded issue files must be approved by a second company user.

Issue File Status

The purpose of the Issue File Status feature is to provide Company users the ability to view and/or manage
issue files loaded or manually entered by the Company. The disposition or status of the file is available.
Positive Pay also offers an option for Company users to receive issue load alerts which will inform if an issue
file is loaded successfully or loaded with errors. (Please refer to Section 11 — Notification Alerts to see

examples of these alerts.) Authorized company users can also manage these files as outlined in the next
section.

8. View Issue File Status

NOTE: The View Issuance File Status user privilege must be enabled.

a. Within the Positive Pay module, click View > Issue File Status.

Heartland Positive Pay % Manage ~ # Perform - Ji Reports ~ = View ~

Issue File 5tatus
Issue Warehouse

We | CO m e Transaction History

N Item Lookup
Please use the above men|
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b. The Issuance Files Status page appears.

Issuance Files Status

Y Filters

10 files totaling $121,719.10

Rows 1-10of 10.

Load Date/Timeli

Date Range
Ejuly 15, 2020 - July 21, 2020~
?

Issuance Load ID File Name Status Transaction Count Transaction Total View/Manage
> 5873 Acme?2 Issue 0721-001.xlIsx SYSTEM_APPROVED 07/21/2020 08:55:38 EDT 15 $12,171.81 Manage
> 5872 Acme Issue 0721-001.xIsx SYSTEM_APPROVED 07/21/2020 08:54:57 EDT 15 $12171.81 Manage
> 5850 Acme2 Issue 0720-001.xlsx SYSTEM_APPROVED 07/20/2020 09:23:31 EDT 15 $12171.81 Manage
> 5849 Acme1 Issue 0720-001.xlsx SYSTEM_APPROVED 07/20/2020 09:23:11 EDT 15 $12,171.81 Manage
> 5833 Acme2 Issue 0717-001.xlsx SYSTEM_APPROVED 07/17/2020 09:39:38 EDT 15 $12,171.81 Manage
> 5832 Acme Issue 0717-001.xlsx SYSTEM_APPROVED 07/17/2020 09:38:54 EDT 15 $12.171.81 Manage

c. Tofilter the date range of files shown, click on the Date Range drop-down.
Date Range

Y Filters

Issuance Load ID

> 5873

> 2872

> 5850

Issuance Files Status

File Name

Acme2 Issue 0721-001.xlsx

Acme1 Issue 0721-001 xlsx

Acme?2 Issue 0720-001.xlsx

10 files totaling $121,719.10

Status

SYSTEM_APPROVED

SYSTEM_APPROVED

SYSTEM_APPROVED

Rows 1-10of 10.

Load Date/Timel:

07/21/2020 08:55:38 EDT

07/21/2020 08:34:57 EDT

07/20/2020 09:23:31 EDT

Transaction Count

Ejuly 15, 2020 - July 21, 2020~

Tomorrow
Taday
Yesterday
Transact
g1 This Month
Last Month
5

Custom Range

§1 E Cancel

d. To narrow the search results, click Filters and a window containing additional search criteria will
appear.

Issuance Files Status

Y Filters

Issuance Load ID

Status

- select status -

Date Range
EMay 1, 2020 - May 31, 2020~

v

Min Amount

7]

Max Amount
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Issuance Load ID

The ID number associated with the specific file.

Status Client Approved The file was approved by the Company.

Client Discarded Client discarded means a Company user decided to discard the issue
file before it was fully processed into the database.

Client Rejected If Issuance Dual Approval is configured for a company, client rejected
means a company user rejected the issue file during the dual approval
process.

Deleted A deleted file has been processed into the system but was removed by
a company user. The file information will still be in the system and can
be found in the Issue warehouse.

Edit Pending A file in this status was loaded with errors. Before the file can be
processed into the database and be displayed in the issue warehouse
or be used in matching, the errors will need to be cleaned up or
removed from the file.

Failed The file failed to load.

Ineligible Items The file contains ineligible items, and the load did not complete
successfully. Ineligible items will need to be removed and the file
reloaded.

Loading The file is loading.

Processing The file is processing.

Queued The file is in line awaiting a status change.

Suspended The file has been suspended.

“Suspended” status can be related to the Issuance Dual Approval
feature. Please refer to the section on Issuance Dual Approval, for
more information about this feature.

System Approved The system is set to default approve the file.

System Discarded Discarded files are files that a user loaded to Positive Pay and had
errors that need to be cleaned up. If the errors are not cleaned up by
deadline displayed under the progress bar, which is three days, the file
will be automatically discarded by the system and no record of it will be
kept.

Min Amount The minimum dollar amount of the entire file.
Max Amount The maximum dollar amount of the entire file.
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e. Once search criteria are selected, click Apply to narrow your search results.

f. Search results are displayed in pages of 25 items. If the search contains more than 25 issue files, the
results will be displayed on multiple pages. Use the navigation buttons at the top of the search results
to review all results.

9. Click the arrow (>) next to the Issuance Load ID to view more useful detail on each issuance file.

Load

Issuance 5 Transaction Transaction
Load ID File Name Status Date/Timel: Count Total View/Manage
v 20465 ASBank_CSV_Issue_0426_ ASBC1_.csv SYSTEM_APPROVED 04/26/2022 9:33 AM 16 $1,004,372.00 Manage
EDT
File Id: 6173

Template Name: CSV Issue

v 20449 MANUAL_1650898055281 SYSTEM_APPROVED 04/25/2022 10:47 AM 1 $600.00 Manage
EDT

File Id: 6157

The ID number assigned by Positive Pay when a file is loaded. This value only comes into

Issuance Load ID play if there is an issuance file loading problem that is not resolved.

The file name assigned by the Company at load time. If the transactions were manually
File Name entered the file name will appear with a prefix of MANUAL followed by a system generated
number sequence for ease of differentiation.

Status Refer to Status Values in previous section above.

Load Date/Time The date and time this file was loaded.

Transaction Count The number of transactions contained within the file.

Transaction Total The total dollar amount of the transaction.

Displays View button if a file has no errors or is ineligible to be edited. It is important to
View note that authorized FI users can click View to get to the Delete button to delete a file. See
below for more information.

Displays Manage button if the file contains errors that can be edited. See below for more

Manage . .
g information.

The ID number assigned by Positive Pay once an issuance file is processed and
committed to the database. If an Issuance Load ID is present but a File ID is not, the

File ID file was received but did not load properly or has not been processed all the way to
the database. The File ID is useful when contacting Heartland Bank about a problem
with a file.

Template Name Issue Template used to load the issue file.




10. Click View button to view the individual issue files. The [File Name] page appears.

< Back to Status

File Status

Queued Processed

® View items: 15 Items totaling $12,246.81 Load Date: 03/02/2021 11:36:23 EST
Rows 1-150f 15.
Account Number Serial Number Amount Payee Mame Status Issuance Date
00x1111 13788 $65.55 Cisco Webex, LLC USED_IN_MATCHING 03/02/2021
oo 1111 13789 $600.00  Jonathan Copeland USED_IN_MATCHING 03/02/2021
Michael Copeland
w0x1111 13790 $260.00 Office Pride USED_IN_MATCHING 03/02/2021
00x1111 13791 $75.00 Richard Canova USED_IN_MATCHING 03/02/2021
w0111 13792 $933.00  Waller Lansden Dortch & Davis, LLP USED_IN_MATCHING 03/02/2021
oo 1111 13793 524.00 Advanced Medical USED_IN_MATCHING 03/02/2021
oox1111 13794 $6,130.00 Citizens Union Bank USED_IN_MATCHING 03/02/2021

sed in matching

WEKP1 Issue 0302-002.xlsx

Approved Completed Deleted

File Status Bar

Displays progress of issue file. This feature automatically refreshes and keeps the user
informed on the status of the file as it goes from Queued to Approved or Failed.

Load Date

The date and time loaded of each item within the file.

Account Number

The Account Number of each item within the file.

Serial Number

The serial number of each item within the file.

Amount The dollar amount of each item within the file.
Payee Name If Applicable, the name of the payee of each item within the file.
Status Available for Matching Items marked as Available for Matching are issue items that have

loaded to the system but have not been matched to a presented
item.

Used in Matching

Items marked as Used in Matching are issue items that a
presented item has been matched to.

New Issuance ltem

This status will only display in a file that was not loaded to the
database for processing.

Ineligible for Modification

Items ineligible for modification are items that have been
matched to presented items and are either in a current status of
paid or returned and can therefore no longer be modified.

Duplicate Issuance

Duplicate issuance items are issue items that duplicate previously
loaded issue items exactly.

Issuance Date

The date of the issued item.
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11. Manage Issue File Status

NOTE:

Y V V

The Load Issuance File user privilege must be enabled.

The View Issuance File Status user privilege must be enabled.
The Delete Issue File Status user privilege must be enabled.
The Manual Issue Entry user privilege must be enabled.

a. Click Manage button to edit errors within an issue file. The [File Name] page appears.

Correct Items.

1) Fields highlighted in red have an error and are blocking the issue file from loading all the way
to the system.

2) When a highlighted field is clicked the user can either select the correct data from a dropdown
or enter it in directly in the field.

3) Once all errors have been corrected, the user can click Save and Submit at the bottom, so the
file is reprocessed.

@ Edit 9 Errors

Line
Number

- 5

Rows 1-90f9,
Account Serial Number Amount Payee Name’ Issuance Date Delete
5555555555 9255 65.55 Cisco Webex, LLC 2020-05-2
elect account - b 9255 z 65.5 T g o = 281202 ri
Cisco Webex, LLC o
b
9256 S600.00 Jonathan Copeland 05/28/2020 m

Delete Items
1) Individual items can be deleted from the errors screen if the option is available.
2) The user would click the trashcan in the Delete column to delete any individual items.

3) Once items have been deleted, the user can click Save and Submit at the bottom, so the file
is reprocessed.

a) The user can also click Delete All Errors at the top of the delete column.
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4) This will allow the rest of the file to process into the system.

EtckiasTams Issue 0529-001.xlsx
File Status

Queued Processing Processed Approved Complete Deleted
Errors occurred during loading. View list below to edit errors. If errors remain after 06/03/20, the issuance file will be automatically discarded.

@ Edit 9 Errors

Rows 1-90f 9,
Line
Number Account Serial Number Amount Payee Name’ Issuance Date Delete
4 5555555555 9255 £65.55 Cisco Webex, LLC 05/28/2020 i
5 5555555555 9256 £600.00 Jonathan Copeland 05/28/2020 i
& 5555555555 9257 £260.00 Office Pride 05/28/2020 i

iii. Discard a File
1) An entire issue file can also be discarded.
a) The user can click the discard button at the bottom of the screen.

b) Another option is to allow the system to discard the file automatically after three (3)
business days.

In both instances, the system will act as if the file never existed and any issue information
from the file will not appear in any reporting or view.



< Back to Status

File Status

Queued Processing

Errors occurred during loading. View list below to edit errors. If errors remain after 06/

@® Edit 9 Errors

Processed

Issue 0529-001

Approved

Rows 1-9o0f9.

lsx

Complete

Deleted

3/20, the issuance file will be automatically discarded.

N::-:Eer Account Serial Number Amount Payee Name’ Issuance Date Delete
4 5555555555 9255 $65.55 Cisco Webex, LLC 05/28/2020 i)
5 5555555555 9256 5600.00 Jonathan Copeland 05/28/2020 i
& 5555555555 9257 5260.00 Office Pride 05/28/2020 i
7 5555555555 9258 0 Richard Canova 05/28/2020 i
8 5555555555 9255 $933.00 Waller Lansden Dortch & Davis, 05/28/2020 ]

LLP
] 5555555555 9260 0 Richard Canova 05/28/2020 [
10 3555555555 9261 $53.36 Richard Canova 05/28/2020 L]
k] 5555555555 9262 $24.00 Advanced Medical, Inc, 05/28/2020 [
12 5555555555 9263 $6,130.00 Citizens Union Bank (v} 05/28/2020 i

O Click any row to select that row for editing

Discard File

iv. Delete a File

1) Users are also able to delete an issue file if none of the items in the file have been used in
matching by clicking on the delete button.

a) When afile is deleted the items will appear in issue views and reporting.
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< Back to 5tatus

File Status

003783

0003783

k3783

003783

03783

WOK3TE3

W03 TES

03783

03783

10035783

WKO03ETES

100STES

O3 TE3

003783

03783

Queued

Account Number

Serial Number

2665

2666

2667

2668

2669

2670

2671

2672

2673

2674

2675

2676

2677

2678

2679

Processed

File processing is complete. View list below to see itermns,

@ View items: 15 Items totaling $12,246.81
9

Amount

$260.00

$75.00

$933.00

324.00

$6,130.00

$53.36

$193.93

$2,800.00

$150.00

$150.00

$750.00

$35.00

$26.97

PGO1 Issue 0303-002.xlsx

Approved

Rows 1-150f 15
Payee Name

Cisco Webex, LLC

Jonathan Copeland

Michael Copeland

Office Pride

Richard Canova

Waller Lansden Dortch & Davis, LLP

Advanced Medical

Citizens Union Bank

Cowvey Seminars

Cuyahoga County Clerk

Michael Farrell

Nesta Archeron
Elain Archeron

Jake Chambers

ABC Carpentry

Office Pride

FedEx

Completed

Load Date: 03/03/2021 15:07:38 EST

Status

AVATLABLE_FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE FOR_MATCHING

AVAILABLE FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVAILABLE FOR_MATCHING

AVAILABLE FOR_MATCHING

AVAILABLE FOR_MATCHING

AVAILABLE FOR_MATCHING

AVAILABLE FOR_MATCHING

AVAILABLE FOR MATCHING

AVAILABLE FOR_MATCHING

AVAILABLE_FOR_MATCHING

AVATLABLE_FOR_MATCHING

AVAILABLE FOR_MATCHING

Deleted

Issuance Date

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

03/03/2021

Delete

Issuance Dual Approval

Positive Pay offers the ability to support dual approval for issuance file loads. If configured for a company,
any manual issue entry files or issue files loaded by the company will be held in “suspended” status until
approved or rejected by a secondary user.

NOTE: Approve/Reject Issue Files permission must be enabled by the FI.
The Approve Issue File user privilege must be enabled.

12. If a company User has manually entered issue items or loaded an issue file requiring dual approval,
another user must approve the issue file or manual entry file. Once the file is loaded and pending
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approval, a message will be sent via email or SMS within 30 seconds to users with the Approve Issue
File user privilege to alert them of files pending approval.

13. Within the Positive Pay module, click View > Issue File Status.

Heartland Positive Pay £ Manage ~ # Perform ~ ol Reports ~ i= View -
Issue File Status
Issue Warehouse

We I CO m e Transaction History

. Itemn Lookup
Please use the above meni

14. The Issuance Files Status page appears. Files requiring dual approval will show a status of
“Suspended”. Click the Manage button to review the file.

: Date Range
Issuance Files Status i
E=March 3, 2021 -
Y Filers >
2 files totaling $24,493,62
Rows1-20f2
Issuance Load ID File Name Status Load Date/Timels Transaction Count  Transaction Total  View/Manage
> BB3E PGOT Issue 0303-002.xlsx SUSPEMDED 03/03/2021 15:07:37 EST 15 51228850 Manage

15. The Issue File review page displays a File Status box at the top of the screen which outlines the
current status of the file. The status bar will be highlighting “Approved/Rejected,” and will note if the
file is pending approval. Approve and Reject buttons display in the File Status box.

< Back to Status PGO1 [ssue 0303-002.xlsx
File Status
Queusd Proceszed Approved / Rejected Completed Deleted
File is pending approval. View list below to approve items.
Apprme Reject

16. A list of each issue item contained in the file will display below the File Status box. Their status will
display as “New Issuance ltem.” The company user can review the entries to determine if the file

should be approved or rejected. In addition, the user can delete the file prior to and after approval by
clicking the Delete button at the bottom of the screen.
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$12,246.81

Account Number

003783

003783

0003783

003783

003783

1003783

003783

003783

003783

03783

0003783

1003783

003783

003783

003783

® Approve items: 15 Items totaling

Serial Number

2665

2666

2667

2668

2665

2670

2671

2673

2674

2675

2676

2677

2678

2679

Amount

$65.55

$500.00

$260.00

$75.00

$933.00

£24.00

$6,130.00

$53.36

$193.93

$2,800.00

$150.00

$150.00

$750.00

$35.00

$26.97

Rows 1-150f 15,

Payee Name

Cisco Webex, LLC

Jonathan Copeland
Michael Copeland

Office Pride

Richard Canova

Waller Lansden Dortch & Davis, LLP

Advanced Medical

Citizens Union Bank

Covey Seminars

Cuyahoga County Clerk

Michael Farrell

MNesta Archeron
Elain Archeron

Jake Chambers

ABC Carpentry

Oiffice Pride

FedEx

Load Date: 03/03/2021 15:07:38

Status

MNEW_ISSUANCE_TTEM

MNEW_ISSUANCE_ITEM

MNEW_ISSUANCE_TTEM

NEW_ISSUANCE_ITEM

NEW_ISSUANCE_ITEM
NEW_ISSUANCE_TTEM

MNEW_ISSUANCE_TTEM

MNEW_ISSUANCE_ITEM

NEW_ISSUANCE_TTEM
MNEW_ISSUANCE_TTEM

MEW_ISSUAMNCE_ITEM

NEW_ISSUANCE_TTEM

MNEW_ISSUANCE_TTEM

MNEW_ISSUANCE_ITEM

WEW_ISSUANCE_I

EM

Issuance Date

03/05/2021

03/05/2021

03/05/2021

03/03/2021

03/03/2021

03/03/2021

03/05/2021

03/05/2021

03/03/2021

03/05/2021

03/03/2021

03/03/2021

03/05/2021

03/05/2021

03/03/2021

Delete

EST

17. If the file is to be approved, click the Approve Button. Once the file is approved, the file status

displays that the file processing is complete.

< Back to Status

File Status

Queued

Processed

File processing is complete, View list below to see items,

PGO1 Issue 0303-002.xlsx

Approved

Completed

Deleted
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a. After the approval is complete, the issue items will display the status “Available for Matching.” The

Delete button will still be available to delete a file after approval.

@® View items: 15 Items totaling $12,246.81

Rows 1-150f 15.

Load Date: 03/03/2021 15:07:38 EST

Account Number Serial Number Amount Payee Name Status Issuance Date
0003783 2665 $65.55 Cisco Webex, LLC AVAILABLE_FOR_MATCHING 03/03/2021
03783 2666 $600.00  Jonathan Copeland AVAILABLE_FOR_MATCHING 03/03/2021
Michael Copeland
WO3TES 26687 $260.00 Office Pride AVAILABLE_FOR_MATCHING 3/03/2021
003783 2668 $75.00 Richard Canova AVAILABLE_FOR_MATCHING 03/03/2021
0003783 2669 $933.00 Waller Lansden Dortch & Davis, LLP AVAILABLE_FOR_MATCHING 03/03/2021
003783 2670 $24.00 Advanced Medical AVAILABLE_FOR_MATCHING 03/03/2021
003783 2671 $6,130.00 Citizens Union Bank AVAILABLE_FOR_MATCHING 03/03/2021
wox3783 2672 $53.36 Covey Seminars AVAILABLE_FOR_MATCHING 03/03/2021
003783 2673 $193.93 Cuyahoga County Clerk AVATLAELE_FOR_MATCHING 03/03/2021
003783 2674 $2,800.00 Michael Farrell AVATLAELE_FOR_MATCHING 03/03/2021
20003783 2675 $150.00  Mesta Archeron AVAILABLE_FOR_MATCHING 03/03/2021
Elain Archeron
003783 2676 $150.00  Jake Chambers AVAILAELE_FOR_MATCHING 03/03/2021
003783 2677 £750.00 ABC Carpentry AVAILAELE_FOR_MATCHING 03/03/2021
003783 2678 $35.00 Office Pride AVATLAELE_FOR_MATCHING 03/03/2021
20003783 2679 526,97  FedEx AVAILAELE FOR_MATCHING 03/03/2021
Delete

b. Returning to the Issuance Files Status page, the file will now display a status of “Client Approved.”

Date Range

Issuance Files Status =t
=March 3, 2021 -

Y Filters >
3 files totaling $25,018.62

Rows 1 -3 of 3.

Load Date/Timels

Issuance Load ID File Name Status Transaction Count Transaction Total View/Manage
» 8851 MANUAL_1614805777127 CLIENT APPROMED  03/03/2021 16:09:37 EST 1 $525.00 Manage
> 883 PGOT Issue 0303-002.xlsx LIENT_APPROVED  03/03/2021 15:07:37 EST 15 $12,246.81

Manage




18. If the file is to be rejected, click the Reject Button.

a. Once thefile is rejected, the file status displays that the file has been rejected by [client username].
The individual issue items will no longer display in the issuance file status.

< Back to Status WEKP1 Issue 1207-003.xlsx

File Status

Queued Processed Rejected Completed Deleted

File has been rejected by FFFTom|ones,

b. Returning to the Issuance File Status page, the file will now display a status of “Client Rejected.

Date Range

EDecember 1, 2020 - March 3, 2021 -

Issuance Files Status

Y Filters >

2 i z =
Issuance Load ID File Name Status Load Date/Timel: Transaction Count Transaction Total View/Manage

> 74 WEP1 Issue 1207-003 xisx CLIEMNT_REJECTED 12/07/202017:19:47 EST 12 12118 View
W

NOTE:

» If an issuance file is currently in “Suspended” status, the file is not released at EOD; but
rather, will remain in this status indefinitely until approved or rejected.

» If an issuance file is currently in “Suspended” status, and the client level setting for
Issuance Dual Approval is disabled, or client user privileges are removed before the
affected issuance files are approved or rejected, the file will remain in the Suspended
status but cannot be managed by the client user. In this circumstance, an Fl user can still
approve or reject the file to move it out of the Suspended status.

Issue Warehouse

Positive Pay provides Companies with the visibility to see the status of all issued items. Authorized users can
modify items in the Issue Warehouse. Companies can use the Issue Warehouse to search for issued items
or for a specific account using one of the many filtering options available.



19. Within the Positive Pay module, click View > Issue Warehouse.

Heartland Positive Pay

£ Manage ~

# Perform ~

ol Reports ~

Welcome

Please use the above men|

= View ~

Issue File Status
Issue Warehouse
Transaction Histary

Item Lookup

20. The Issue Warehouse page appears.

Y Filters

Itemn ID

> 2386366

> 2386349

» 2386348

» 2386347

> 2386346

Issue Warehouse

Account

Number

w3783

oe3783

ox3783

%3783

WRx3783

Serial

Number

100945

2679

2678

2677

2676

Payee Name

Moe Green

FedEx

Office Pride

ABC Carpentry

Jake Chambers

Rows 1 - 25 of 31.

Issue

Type

ISSUED

ISSUED

ISSUED

ISSUED

ISSUED

31 transactions totaling $25,018.62

Match Status

OUTSTANDING

OUTSTANDING

OUTSTANDING

QUTSTANDING

QUTSTANDING

Amount

£525.00

$26.97

$35.00

%750.00

£150.00

Load
Date/Timeld

03/03/2021 16:09:37
EST

03/03/2021 15:07:38
EST

03/03/2021 15:07:38
EST

03/03/2021 15:07:38
EST

02/03/2021 15:07:38
EST

Date Range
EMarch 3, 2021~

>

Issuance

Date Update

03/03/2021 7
03/03/2021 -
03/03/2021 >
03/03/2021 v

03/02/2021 Vs

21. To filter the date range of items shown, click on the Date Range drop-down

Issue Warehouse

Y Filters

Account

ItemID  Number

> 2386366 03783

Serial

Number

100945

31 transactions totaling $25,018.62

Payee Name

Moe Green

Rows 1- 25 of 31.

Issue
Type Match Status
ISSUED OUTSTANDING

Amount

$525.00

Load
Date/Timeli

Date Range
EMarch 3, 2021~

Tomorrow
Today
Yesterday
Last 7 Days
This Month
Last Month

Custom Range

03/03/2021 16:09: Cancel

EST
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22. To narrow the search results, click Filters and a window containing additional search criteria will appear.

Date Range
Issue Warehouse "
EMarch 3, 2021~
Y Filters v
Account’ Serial Number Date Range Filter Type
Pt Selected. 2 O Issue Date @ |oad Date
Min Amount Serial Number Range
% Min Serial Num Max Serial Num Issue Type
Max Amount - select issue type - v
3 Match 5tatus
- select match status type - hd
Apply
Account Type an account name or the last 4 digits of the account number.

Serial Number

Type the item serial number for a specific issued item.

Date Range Issue Date: If selected, issue items will be filtered by the issue date rather than the
Filter Type load date.
Load Date: If selected, issue items will be filtered by the load date rather than the
issue date.
Min Amount The minimum dollar amount.
Max Amount The maximum dollar amount.
Serial Number Range Min Serial Num Type the minimum serial number in the range
Max Serial Num Type the maximum serial number in the range.
Issue Type Issued The check has been issued for payment.
Voided The check has been voided by maker.
Stopped The check has a stop payment placed on it.
Match Status Paid There was a presented item for the issued item, and it has been
paid.
Returned There was a presented item for the issued item, and it has been
returned.
Outstanding There has been no presented item for the issued item, it remains
outstanding for 180 days as a default unless specified otherwise
by your financial institution.
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NOTE:

> Issuance data is available for 1 year as the default setting, but this can be
configured differently by the FI.
> If Additional Issue Fields are being used, a section to filter by that data will display.

23. Once search criteria are selected, click Apply to narrow your search results.

24. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items, the

results will be displayed on multiple pages. Use the navigation buttons at the top of the search results
to review all results.

79 transactions totaling $61,748.44

Rows 1 - 25 of 79O,

Account Serial
ItemID Number Number
Item ID The ID number associated with the specific file once an issuance file is processed and

committed to the database.

Account Number Displays the Account Number for the item.

Serial Number Displays the issued item serial number.




Issue

Payee Name Type Match Status
Payee Name Displays the name of the payee for the item.
Issue Type Issued The check has been issued for payment.
Voided The check has been voided by maker.
Stopped The check has a stop payment placed on it.
Match Status Paid There was a presented item for the issued item, and it has been paid.
Returned There was a presented item for the issued item, and it has been
returned.
Outstanding There has been no presented item for the issued item, it remains
outstanding.
Load : ; Issuance
Amount Date/Timeli Date Update
Amount Displays the dollar amount for the issued item.

Load Date/Time
Issuance Date

Update

Date and time the item was loaded.
The date of the issued item.

Click the pencil icon to update item’s Amount, Status, or Issuance Date.
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25. Click the arrow (>) next to the Item ID to view more useful detail on each issued item. The
information shown in this drop-down is an audit history of all the activity that has occurred on the

issue item.
Account Serial Issue Load Issuance
ItemID  Number Number Payee Name Type MatchStatus  Amount  Date/Timeld Date Update
W 3393032 xxxx3579 113687 Richard Canova ISSUED OUTSTANDING $30.00 04/22/202212:13 PM 04/22/2022 pa
EDT
Status Payee Amount Issue Date Updated By Updated Date/Time
ISSUED Richard Canova $30.00 04/22/2022 sdelaerel 04/22/2022 12:13 PM EDT
Status Issued The check has been issued for payment.
Voided The check has been voided by maker.
Stopped The check has a stop payment placed on it.
Payee Displays the payee name of the issue item.
Amount Displays the dollar amount for the issued item.
Issue Date The date of the issued item.
Updated By The user who updated the issue item.
Updated Date/Time The date and time this issued item was updated.

26. Modifying Issue ltems.

a. Issue items can be modified by users with a Load Issue File or Manual Issue Entry privilege. Issue
items can only be modified if the match status = outstanding. Click the edit pencil button under the
Update column to update the issued item.

Account Serial Issue Load % : Issuance
ItemID Number Number Payee Name Type Match Status Amount Date/Timels Date Update
P 2276362 xox1111 9263 Citizens Union Bank (v) ISSUED QUTSTANDING  $6,130.00 05/29/202010:04:33  05/28/2020 s
EDT




27. The Update Issue Item pop-up window appears.

Update Issue Item
Serial Number Amount Payee Name’ Status Issuance Date
0263 5130 Citizens Union Bank (v} ISSUED b = 05/2%/2020
o
Save
Serial Number Check serial number. This cannot be updated on an existing issued item.
Amount Amount of the issued item. The amount can be updated.
Payee Name The name of the Payee associated with the specific issued item. The payee name can be
updated.
Status Issued The check has been issued.
Voided The check has been voided by the maker.
Cancelled The check is being cancelled by the maker. Please see next paragraph
below.
Issuance Date The date of the issued item. The issuance date can be updated.

28. Issue Item Cancel: An outstanding issue item can be updated to Cancelled status. It is important to
note that only outstanding issue items will have the option to be changed to Cancelled. Once the issue
item is updated to cancelled, it will disappear from all views except Item Lookup, Active Reconciliation
(if enabled), and Audit Report for historical purposes.

Update Issue Item

Serial Number Amount Payee Name’ Status Issuance Date
113687 30 Richard Canova ISSUED ¥ £2 04/28/2022
y ISSUED

VOIDED
CANCELLED

Save




29. Click Save.

Issue updated.

30. A copy of the Issue Warehouse can be downloaded by clicking the “Download As CSV” button at
the bottom of the Issue Warehouse screen.

ltem Lookup

Positive Pay provides companies with the ability to look up all recorded data on individual issued items with

the Item Lookup feature.

1. Within the Heartland Positive Pay module, click View > Item Lookup.

Heartland Positive Pay  ®Manage v  # Perform~  JiReports v | = View »
Issue File Status
Issue Warehouse

We I CO m e Transaction History

Please use the above meni L

2. The Item Lookup page appears. All fields are mandatory.

Item Lookup
Account’ Serial Number
- not selected - ¥
Account

Select the Account drop-down to display a list of the Company’s
Accounts.

Serial Number Enter the serial number of the item.

3. Once search criteria are selected, click Apply to complete the item lookup.
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4. Search results for the item will be displayed. Within this screen, the lifecycle of the issued item will be

displayed.
Item Lookup
Account’ Serial Number
The One and Only - xxxx1111 (ASBank Client 1 - ASBC1) v 11548
Apply Reset
Account Number: xooo1111 Serial Number: 11548 View Check Image
Transaction Date: 04-15-2021 Original Serial Number: 11548 Exception Reason: Amount Mismatch
Payment Date: 04-15-2021 Original Amount: $27.00 Payee Match Score: Error analyzing payee name
Transaction ID: 45566 Issuance Payee Name: FedEx Disposition Created: 04/15/2021 15:00:00 EDT
Debit Amount: $27.00 Issuance Serial Number: 11548
Current Status: Pay-5System Issuance Amount: $180.00
Issuance Status: IS5UED
Transaction Date: 04-15-2021 Original Serial Number: 11548 Exception Reason: Duplicate Presentment
Payment Date: 04-15-2021 Original Amount: $127.00 Payee Match Score: Error analyzing payse name
Transaction ID: 45567 Issuance Payee Name: FedEx Disposition Created: 04/15/2021 15:00:00 EDT
Debit Amount: $127.00 Issuance Serial Number: 11548
Current Status: Pay-System Issuance Amount: $180.00
Issuance Status: ISS5UED
Issuance Date: 04/15/2021 Update By: mfleetwood! Payee Name: FedEx
Updated Date/Time: 04/15/2021 13:34:17 EDT Transaction Id: 45566 Match Status: PAID
Load Date/Time: 04/15/2021 13:34:17 EDT Issue Type: ISSUED Amount: $180.00

Other Options Prior to Item Presentment

If a Company needs to make changes to an item prior to item presentment, there are three options for
doing so within Positive Pay. Examples of changes that would fall under this category would be when items
originally issued are updated to Voided or Stopped status, or to overwrite existing item information such as
changes in amount and/or payee.

1. Modifying Issue Items

Issue items can be modified in the Issue Warehouse.

2. Manual Re-Entry

To change individual items previously submitted, a Company user can overwrite the previous item as
follows:

a. Within the Heartland Positive Pay Module, click Perform > Manual Issue Entry.
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Heartland Positive Pay =~ #Manage ~ | # Perform - diReports ~ = View

Issue File Load
Manual Issue Entry
Paid Mo Issue Match '.] e

Please use the above menu to select an action

b. The Manual Issuance File Entry page appears.

Manual Issue Entry

Account? Auto populate next check number:
- not selected - v
Row Serial Number Amount Payee Name’ Status Issuance Date
ISSUED - 05/29/2020

€ Click any row to select that row for editing

Save

c. Create a Manual Entry for the item to be changed. The serial number must match the previously
submitted item. Fill out all fields, updating the fields that need to be overwritten with the correct
information.

d. When all pertinent manual issuance files have been re-entered, click Save button.

e. The Manual Issuance File detail page appears.

< Back to Status MANUAL_1614805777127

File Status

Queued Processed Approved Completed Deleted

File processing is complete. View list below to see item.

@® view item: 1 Item totaling $525.00 Load Date: 03/03/2021 16:09:37 EST

Rows 1-1of1.

Account Number Serial Number Amount Payee Name Status Issuance Date

Xxx3783 100945 $525.00 Moe Green AVAILABLE_FOR_MATCHING 03/03/2021

Delate
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3. File Reloads

To change multiple items that were previously submitted, a company can use the Issue File Load function
to reload and overwrite previous items in an Issue File.

a. Once you have prepared your Issue File with all items that need to be overwritten, including the

corrected information in the appropriate fields, upload the Issue File.

4. Prior to item presentment, these changed/overwritten items can be seen in the Issue Warehouse. Once
within the Issue Warehouse screen, click the arrow (>) next to the Item ID to view more useful detail on
each issued item. The information shown in this drop-down is an audit history of all the activity that has

occurred on the issue item.

As you can see in the figure below, there are three issue items that have been updated/changed. The

updates/changes from the most recent entries will overwrite the previously loaded issue item.

Issue Warehouse

Y Filters

Item ID

v 2278881

Status

VOIDED

ISSUED

» 2278880

v 2778879

Status

ISSUED

ISSUED

v 2278878

Status

STOPPED

ISSUED

ns totaling $24,443.62

Rows 1 - 25 of 30.

30 transactio
Account Serial
Number Number Payee Name
20003210 3454 FedEx
Payee Amount Issue Date
FedEx $26.97 07/21/2020
FedEx $26.97 07/21/2020
xxx3210 3493 Office Pride
00063210 3492 ABC Carpentry
Payee Amount Issue Date
ABC Carpentry £850.00 07/21/2020

ABC Carpentry

WO3210 3491

Payee

Jake Chambers

Jake Chambers

£750.00 07/21/2020

Jake Chambers

Amount Issue Date

$150.00 07/21/2020

$150.00 07/21/2020

Issue

Type Match Status

WOIDED OUTSTANDING

Updated By

SallyAcme

SallyAcme

ISSUED OUTSTANDING

ISSUED OUTSTANDING

Updated By

SallyAcmet

SallyAcme

STOPPED OUTSTANDING

Updated By

Sallyacme

SallyAcmet

Load
Amount Date/Timeli
$26.97 07/21/2020 08:55:38

EDT

Updated Date/Time

07/21/2020 13:08:19 EDT

07/21/2020 08:55:38 EDT

$35.00 07/21/2020 08:55:38
EDT
$850.00 07/21/2020 08:55:38

EDT

Updated Date/Time

07/21/2020 13:09:50 EDT

07/21/2020 08:55:38 EDT

$150.00 07/21/2020 08:55:38

EDT

Updated Date/Time

07/21/2020 13:08:44 EDT

07/21/2020 08:55:38 EDT

Date Range

Bjuly 21, 2020~

Issuance
Date

07/21/2020

07/21/2020

07/21/2020

07/21/2020

>

Update

d
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Other Options After Item Presentment

. Pay & Issue
Single Pay & Issue is an Enterprise feature which allows a company to allow the system to create an issue

item they failed to send in. This is used for balancing.

. Mass Pay & Issue
This feature provides a way to handle system creation of multiple issue items instead of the user having to

click Pay & Issue for each individual issue item if the Company failed to send an entire file and it resulted in
a lot of no issue exceptions. In addition, it provides a mass pay decision, instead of addressing them one at
a time.
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4. EXCEPTION IDENTIFICATION

Heartland Positive Pay is configured to identify exceptions on issue items in a specific order. Once the first
exception is triggered on an issue item, the system does not evaluate the item further. If an item is flagged
with an exception and is deferred to the Company user for decision, it must be noted that further analysis will
not be performed. Company users should be conscious when paying an exception that other validations may
not have been performed, so they should examine the item.

Listed below are the possible Exceptions and the order in which they are flagged by Positive Pay.

Exception
Order

1

2

Exception Code

Issuance not found
Issuance already used

Issuance voided

Issuance stopped

Issuance amount mismatch

Amount over limit

Issuance date in future

Issuance stale dated

Issuance payee mismatch

Reason

Check presented where no issue item is found to match against.
Check presented with a serial number previously presented.

Check presented with a serial number of an issue item marked with a
void status.

Check presented with a serial number of an issue item marked with a
stop status.

Check presented where amount of check differs from issue amount.
Transaction amount is over the limit.

Check presented with a date that is before the issuance date on the
issued item.

Check presented with a date that exceeds the specified number of
stale days for the account.

Check presented where payee name differs from issue payee name.
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5. DECISIONING EXCEPTIONS

The primary objective of Positive Pay is to give users the opportunity to make pay and/or return decisions on
checks presented for payment on accounts enrolled for the service. The decision function is performed in the
Transaction History screen.

Transaction History

NOTE:

» Transactions are stored for 12 months.

> The Transaction History user privilege must be enabled to access this screen.

> If the user has been granted the Change Status user privilege and the transaction is
available to decision, the Pay and Return buttons will be available for use.
Transactions that will be paid will have green shading as a background.

» Transactions that will be returned will have yellow shading as a background.

» Transaction status cannot be changed after the EOD cut-off time.

A7

Positive Pay provides a function for Companies to search and view the status of checks presented
on enrolled accounts, and to make decisions on presented items. Users can use Transaction
History to search for presented check items for a specific account using one of the many filtering
options available. It is important to note that the default filter setting is Exceptions Only. Additional
transactions may be available to view and decision (such as reverse positive pay items); however,
this will not be displayed unless the Exception filters option is set to Show All Transactions.

1. View Transaction History

Within the Heartland Positive Pay module, click View > Transaction History. The Transaction History
page will display all current day transactions for all accounts to which the user has access.
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Date Range
Transaction History M Dec 23, 2025 -

T Filters »

Transaction ID Account Mumber Serial Mumber Credit Debit Datel: Drecision Exception
3 1338857 KRRRTTTT 21748 $43L71 12232025 Pay | Return $
» 1338851 WHRTTTT 217485 $600.00 127232025 Pay | Return $
» 1338850 WRTTTT 217484 $65.55 12/232025 Pay | Return $
Transaction ID Unique ID assigned by the Positive Pay system when transactions are loaded.

Account Number Account number the check was presented against.

The check number presented for payment.

Serial Number Clicking on the serial number will display the front and back images of the check. If an eye
icon appears in the serial number column, this denotes an item that was processed with no
serial number. Clicking on the eye icon will display the check image, if available.

Credit This column will display if deposit information has been entered into the system.
Debit This column displays checks.
Date Date the check was presented for payment or loaded to Positive Pay.

Displays buttons that indicate both the current Pay/Return status of the item and the available
Decision options for decision.

Exception If the transaction is an exception, an exception identifier will appear in this column.




a. To filter the date range of items shown, click on the Date Range drop-down.

Date Range
Transaction History & oct20, 2025 -
“heck Mass Pay Payee Review (0) Start Date’ End Date™ TamGrTow
10¢3042025 1043042025
October 2025 Hovermnber 2025
ROV Su Mo Tu We Th Fr Sa  5u Mo Tu We Th Fr Sa  Testerday
Type Description Account Date 8 @ 30 01 1 3 4 1 Last 7 Days
6 7T B o 10 M 2 2 4 5 6 T 8 +iz Month
NoTra J This Motk
12 13 14 15 15 17 18 9 0 11 12 13 14 15
Last Mointh
10 20 24 22 23 24 25 16 17 18 19 20 M 22
Custom

EERET AT IY 20 JEY 23 24 25 26 27 28 29

3“‘23“55mcancel

b. To narrow the search results, click Filters and a window containing additional search criteria will

appear.
Date Range
Transaction HIST.DI'}I' & Dec 23, 2005 =
Mass Pay & Issue Payee Review (0)
T Filters v
Agcount’ Exteplions B Default Ttems
Any - ATy o
Amount Azt Rangs Exception Type Transaction Status
¥ Ay w Pay “
Pay-System
Serial Number Serial Numiser Range Pending Dual Approval Pay-Fl
Pay-Liser
Ay - Retwrm
Returm-System
Positive Pay Type r
. i Transaction Type Return-Fl
Any - Return-Liser
g l'l‘-n:r. - ¥
1 ( key to select multipbe status

Transaction ID
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Account

Type an account name or the last 4 digits of the account number into the field to view
transactions for one specific account or select an account from the drop-down menu.

Amount

Enter a specific amount of a transaction.

Amount Range

Click the hyperlink above the Amount field to enter an amount range or a maximum or
minimum amount of transaction.

Min Amount Type the minimum check amount into the field.
Max Amount Type the maximum check amount into the field.
The user may select from the drop-down to filter by one of the following:
> Exceptions Only: Only exceptions are displayed.
Exceptions » Show all Transactions: Exceptions and non-exceptions are displayed.
P » No Exceptions: Only non-exceptions are displayed.
The default will be set to “Exceptions Only”; however, the user can click the “Default” checkbox
to select a different option to be the default for future filtering.
Exception Type Select an exception reason from the drop-down.
If Decision Dual Approval has been enabled, transactions may be in a pending status awaiting
Pending Dual an Approve or Deny decision. Select from the Pending Approval drop-down menu to display
Approval transactions pending approval or not pending approval. The default setting is to Show All

Transactions.

Transaction

Type

This filter defaults to Any.

Transaction ID

A unique number assigned to the transaction when loaded.

Items

Defaults to Any Items.

Transaction
Status

Pav-Svstem The system is set to default pay this check. If no action is
y-oy taken before EOD, the check will pay.
Pay-FI The check was paid by the FI.
Pa
y A user changed the transaction status from a Return to a
Pay-User
Pay status.
Pendina-Pa The check was paid by a User but awaits approval or
g-ray rejection because Decision Dual Approval is enabled.
Return-Svstem The system is set to default return this check. If no action is
y taken before EOD, the check will be returned.
Return Return-Fl The check was returned by the FI.
A user changed the transaction status from a Pay to a
Return-User
Return status.
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c. Once search criteria are selected, click Apply to narrow your search results.

d. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items,
the results will be displayed on multiple pages. Use the navigation buttons at the top of the search
results to review all results.

oo
WL
&h
(mp]

-]

45 debit transactions totaling $34

[

“--'a."a.""'- 1 ?r) or -I-':.

Fd

e. Summary Debit and/or Credit transaction totals are also displayed at the top of the screen above the
navigation buttons.

f. Click the arrow (>) next to the Transaction ID to view more useful detail on each issued item.
The information shown in this drop-down is an audit history of all the activity that has occurred
on the issue item.

Date Range
Transaction History 8 Dec 23, 2025 -

Mass Pay & Issue Payes Review (D)

Y Filters >

|

Transaction ID Account Number Serial Humiser Credit Debit Dateli Decision Exception

W% 1338852 WoTTTT 217485 343271 1272372035 Pay RERM §

Account Name: SeptaMatters Payment Date: 12/2Z2/ 2025 Adjust Potes (D)

Positive Pay Type: payee Loaded Exception Reason: Amount Mismatch Current Status: Pay-System
Issuance Payee Name: Quentin Quest

Issuance Serial Number: 217486

Issuance Amount: $933.00

Issuance Date: 12/22/2025

Original Serial Mumber: 217486

Original Amount: 432,71

[ — woeoTTTT 217485 $600.00 12/23/2025 e [ §

Acount Name: SeptaMatters Return Dates 1272372025 3:30 AM EST Motas (0

Positive Pay Type: payee Return Reason: Amount b Current Status: Return-User
Issuance Payee Name: Pamela Principle Loaded Exception Reason: Amount Mismatch

Issuance Serial Number: 217485

Issuance Amount: $30.00

Issuance Date: 12/22/2025

Original Serial Mumber: 217485

Owiginal Amount: S600.00




Account Name

The name assigned to the account.

Positive Pay Type

This indicates the type of positive pay that the account is set for:
Standard, Reverse and Payee are the different types that could display here.

Issuance Payee Name

Name of payee submitted with the transaction presented for payment.

Issuance Serial Number

Serial number on the issued item uploaded by the company.

Issuance Amount

Amount on the issued item uploaded by the company.

Issuance Date

Date the issued item uploaded by the company.

Original Serial Number

Serial number submitted with the transaction presented for payment.

Original Amount

Amount submitted with the transaction presented for payment. This number may be
different than what is displayed in the top line.

Return Date

Date the item was returned.

Payment Date

Date listed within the transaction file.

Return Reason

Reason for return. Company users can click on the Return Reason hyperlink to open
a pop- up window to select a different return reason as needed.

v 13388 ! OO 12T - 220 §
1 Farm Septafdatieng LY

Loaded Exception
Reason

Originally Cleared Date

In the case of Duplicate Presentment exceptions, the Originally Cleared Date will
display the cleared date of the originally presented item.

Originally Cleared
Amount

In the case of Duplicate Presentment exceptions, the Originally Cleared Amount
will display the cleared amount of the originally presented item.

Originally Cleared
Status

In the case of Duplicate Presentment exceptions, the Originally Cleared Status
will display the status of the originally presented item.

Payee Match Score

The score displayed here is the score assigned by the payee analysis engine when
the payee name on the check was compared to the payee name provided on the

issue item file.

Payee Analysis

Displays as Pass or Fail based on payee scoring.

Notes

This feature allows FI and Company users to make notes regarding a transaction in
Pay or Return status. The Note button displays how many Note entries have

been made on a transaction. Click on the Notes button to enter in pertinent
information regarding a transaction.
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2. Change Transaction Status

a. Ifthe user has been granted the Change Status user privilege and the transaction is eligible for a
decision, a Pay/Return button will appear for use. If the transaction is not eligible for a decision, the

button will display as a single button with no option for update.

The table below explains the various decision options.

Decision Buttons

Status

Actionable (Y/N)

Pay - System

Yes

‘ Pay ‘ Return If the User takes no action, the item will The user may confirm payment by
. ) . clicking “Pay” or change the decision
be paid o .
by clicking “Return
Pay-User / Pay-Fi Yes
Pay Return Either a Company User or the Fl has The user may change the decision by
marked this item to “Pay” clicking “Return”
—— Return — System Yes
Pay Return If the User takes no action, the item will |, 1N€ User may confirm return by -
clicking “Return” or change the decision
be Returned T
by clicking “Pay
Return-User / Return-Fl Yes
Pay Either the Company User or the Fl has | The Company User may change the

marked this item to Return

decision by clicking “Pay”

Pay-System / Pay-Fl / Pay-User

This item has been Paid

No

The Company User is unable to
change the decision on this item

=

Return-System / Return-Fl / Return-User

This item has been Returned

No

The Company User is unable to
change the decision on this item

The Company has Dual Approval
enabled and this item has been
changed to a Pay status and needs to
be approved by a secondary user

Yes

The Company User may cancel the
Pay decision request by clicking the
Pending button a second time
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b. There are various reasons an item could be an exception. The table below explains the various

exception reasons.

Symbol

Exception Code

Exception Reason

Issuance Not Found

Check presented where no issue item is found to match against.

Issuance Already Used

Check presented with a serial number previously presented. (Duplicate)

Issuance Voided

Check presented with a serial number of an issue item marked with a void status.

Issuance Stopped

Check presented with a serial number of an issue item marked with a stop status.

Issuance Amount
Mismatch

Check presented where amount of check differs from issue amount.

Amount Over Limit

Transaction amount is over the limit.

Early Presentment

Check presented with a date that is before the issuance date on the issued item.

Issuance Stale Dated

Check presented with a date that exceeds the specified number of stale days for
the account.

Issuance Payee Mismatch

Check presented where payee name differs from issue payee name.

Sk H O ® 00 QL

Treated as Exception

When an account is set to Reverse Positive Pay, and the Treat All Checks as
Exceptions option is configured, all incoming checks are marked as an exception
and presented in the Item Warehouse for review and decisioning.

3. Change Status — Pay
a. Ifthe Current Status on an issued item is set to Return, the Company can opt to change the status to
Pay if the Company determines the check should be paid.
b. Click the Pay button under the Decision column.
Transaction ID Account Number Serial Number Credit Dbt Dateld Decision Exteption
¥ 1338852 BT TTT 43271 12372025 Prw | Return 8
> 133885 007777 SE00.00 12232025 g gy m &
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c. The Confirm Paying Exceptions pop-up window may appear if the user decides to Pay an item that is
set to Return. The window displays an image of the check and other details for the user to review
before confirming that they want to pay the item.

Confirm Check

(imecMomn 0 g.ob Testitem . Jaress |
| v h, voa Greck Nurber 21745 |
: . s Negenile Date December 22, 2025 :
I :'"""'”"""'"'”"""I I
| PavTothe Pamela Prince :$600.00 ¥
: e |
| Amount Six hundred and 00 cents :
1 Dellars |
| memo ISN: 156117050 signawre _ 2 DELa®re \
e e e e e e e e e e e e e e e — o — — — — — — — — — _—

eid2i?eLbL by ?RPPRRP??YP2L7LAS +OOO0O00GOO0OO.

Exception Reason: Amount Mismatch
Issuance Serial Number: 217485 Issuance Amount: $30.00

Issuance Payee Name: Pamela
Principle

Amount and Serial Number may be adjusted after Confirm

d. Once the user has reviewed the information presented, they can decide to Confirm so that the check
will be paid or to Cancel so that the check will be returned.

e. The Pay button will turn green, and the Current Status in the expanded details will update to “Pay-

User.”
v 1338851 0007777 217485 $600.00  12/23/2025 Return $
ACCoumt Name: ':EP'TElh" atters Pa’yT"E nt Date: 120502025 Adm MNates (0]
Positive Pay Type: payee Loaded Exception Reason: Amount Mismatch

Current Status: Pay-User
Issuance Payee Mame: Pamela Principle

Issuance Serial Mumber: 217485
Issuance Amouwnt: $30.00
Issuance Date: 1272272025
I:-'i-'=1ir'.5 Serial Mumber; 217485

Orriginal Amount: $600.00

4. Change Status — Return

a. Ifthe Current Status on an issued item is set to Pay, the Company can opt to change the status to
Return if the Company determines the check should not be paid.
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b. Click the Return button under the Decision column.

Transaction ID Account Number Serial Number Credit Diebit Datel Decision Exception

» 133B852 XTI 217486 34321 127232025 -. -]

Pay Return

» 1338851 00T TTT 217485 $600.00 1272372025 . $
Pay

c. The Check Return Reason pop-up window appears. Select the appropriate reason for the Check
Return. Please note that the list of return reasons displayed are the system default but may vary
depending on the way the financial institution defines them.

Select a check return reason:

Amount Incorrect
Duplicate
Fraudulent

Prior Stopped
Prior Viosd

Refer to Maker
Serial # Incormect
Signature Irregular

Signature Missing

Stale Dated

Amount Incorrect The dollar amount is incorrect.

Duplicate This item has already been presented.

Fraudulent Fraudulent item.

Prior Stopped This item has a stop payment placed on it.

Prior Void The item has been previously voided.

Refer to Maker Refer to the maker of the check.

Serial # Incorrect The serial number on the item is incorrect.

Signature Irregular The signature does not match.

Signature Missing The item is missing a signature.

Stale Date The presenlted .item ha's a date greater than the number of stale days allowed on the
corresponding issued item.




d. Click Save.

Check will be returned

e. The Return button will tum Red, and the Current Status in the expanded details will update to

“Return-User.”
1338852 WO T I 217485 £432.71 122372025 Pay m
Account Mame: SeptaMatters Return Date: 12/23/2025 3:30 AM EST P Mates (01
Pasitive Pay Type: payee Return Reason: Amount M
¥ Type: ey Current Status: Return-User
Issuance Payes Name: Cuentin Quest Loaded Bxception Reason: Amount Misrmatch
IEsuance Serial Number: 2174385

Issuance Amount: $933.00
Issuance Date: 1272272025
Original Serlal Number: 217486

Original Amount: $432.71

5. A copy of the Transaction History can be downloaded by clicking the “Download As CSV” button at
the bottom of the Transaction History screen.




Review Payee

Although payee analysis is a good technology, it is not a perfect technology. The Review Payee functionality
has been introduced to allow users to visually inspect presented items to ensure that fraudulent transactions

that may not have triggered any exceptions are identified.

1. If Payee Positive Pay is configured, the Review Payee feature may be available in Transaction History.
Review Payee allows users to easily view non-exception items for transactions on accounts enrolled in

Payee Positive Pay.

2. From within Transaction History, the Payee Review button will appear at the top of the screen with the

total number of non-exception items available for review in parenthesis. Click the Review Payee button to

proceed.

T Filters

Transaction ID

» 1338852

» 1338851

» 1338850

Transaction History

Mass Pay & Tssue

Payee Review (0]

Account Number Serial Number Credit Debit Dateli

wXRITI7 217486 $432.71  12423/2025
¥MXRTTTF 217485 $600.00 124232025
oXRTTT7 217484 $65.05  12/23/2025

Date Range

B pecz3, 2035 -

Decision

Pay Return

Pay Return

Pay Return

Exception

5

$

5

3. The Payee Review screen appears. The Payee Review page will display all current day non-exception

transactions for all accounts to which the user has access.

= Back

¥ Filters

Transaction ID:

Acoount Number:

Serial Number:
Amount:

Issuance Payes:

Transaction ID:
ACCoUNT Number
Serial Number:
Amount:

Issuance Payee:

Payee Review

Transaction Information

1276023
KouKA580
08
530,00

Matalie North

1276012
WoodEa0
9097
$53.36

Craig Callahan

>
Image Change Status
i
: DATE AMOUNT '
| T3 0 e LRI \
1 i
| Pay To the - : — AT f - !
: Or:“ of Natalie Morkey /) |-—I ::':I = = - |—} l_lll | ] :
| NSRS/ NS :
| Amount —Thirty_and No gefis | i \ | | I i |
: =" 0T 0U=Usd "
| Memg _1SN: 46103819 Signature S e cBtE |
1 I
e e e e = o —
TR R A TH ?LEAD ?LEAD*T DA +DO00DD3I000S
Test Capture Only
M Megotable
T R i RGN
0304 | eT § ssm
Pay Craig Callahan
Order  Fifty five and No cents
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Transaction ID

Unique ID assigned by the Positive Pay system when transactions are loaded.

Account Number

Account number the check was presented against.

Serial Number

The check number presented for payment.

Amount

The amount of the check.

Issuance Payee

Name of payee submitted with the issuance presented for payment.

Image View

The front image of the check will display for review

Change Status

The Return button is available for the user to change the status of the transaction to
Return.

4. To narrow the review screen results, click Filters and a window containing filter criteria will appear.

FPayee Review
¥ Filters v
Account’ Serial Mumber aria Mumtar Rangs
ArTRoLNt
5
Type an account name or the last 4 digits of the account number into the field to view
Account . e
transactions for one specific account or select an account from the drop-down menu.
Amount Enter a specific amount for the transaction.
Amount Click the hyperlink above the Amount field to enter an amount
Range range or a maximum or minimum amount of transaction.
Min Amount Type the minimum check amount into the field.
Max Amount Type the maximum check amount into the field.

Serial Number

Type the item serial number for a specific issued item.

Serial Number|
Range

Click the hyperlink above the Serial Number field to enter a serial number range or a maximum
or minimum serial number.

Min Serial #

Minimum serial number

Max Serial #

Maximum serial number

5. Once search criteria are selected, click Apply to narrow your results.

61



6. Results are displayed in pages of 25 items. If the Review Payee screen contains more than 25 items, the
results will be displayed on multiple pages. Use the navigation buttons at the top of the review screen to

review all results.

Rows 1

) ) - N

- 25 of 29.

7. To change the transaction status to Return, click the Return button.

Transaction Information Image Change Status
Transaction 10 1276012

I . Waerison
Account Number: axEdBED |-.f; P — Test Capture n""'

: . B Negatiahle

Yowr Uiy, Siaie | 27845
Serlal Number: opo7 [ OATE CHECE WD | ABOUNT

T F] Y q4

Amount: $53.36 o304 2024 o | sson
Issuance Payee: Cralg Callahan pay  Craig Callahan

To The & Return

Order  Fifly [ive and No cents

o ** Void ** Void ** Void **

1SN: 46103808 S bewfe

BIPEAT LG b

2LEAD ZLEAD=909 7 +D0O0D00S5 500

8. A pop-up window will display to select a check return reason. Select the appropriate return reason, and

click the Save button to proceed.

Select a check return reason:

® Amount Incorrect

_) Duplicate Presentment
Fraudulent
Prior Stopped
Prior Void
Refer to Maker
Serial # Incorrect

) Signature Irregular
Signature Missing

) Stale Dated

Save
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9. Once the return reason is saved, the user will be returned to the Review Payee screen, and the Return
button will be displayed as an Undo button. If the user determines that the Return should be undone,
clicking the Undo button will change the status back to Pay, and the screen will revert the button to

Return.
Transaction Information image Change Status
Transaction ID: 1276012 - :
Xk 20 Mima
Account Number: 580 I Test Capture Only

Vioust Tity, State 17145 Han-Ne gotiable

Serial Number: a7 i  inecewh ] ARSOUN T ]
53,35 030040204 | T ]5 55,000 |
e B v )

AMmount:

Issuance Payee: Craig Callahan Pay Craig Callahan
T Tha
m ]-I.ﬂ:. rl.'\.'l..' il.'lI.LI NH Cents
(4. ]

** Void ** Void ** Void **

15N 46103808 3 bewfe

T T Y 1 ILEAD LEBEOD®S097 »#D0O0D0O055004
Transaction 10 1276009
Account Mumber: KAEE0 P Test Capture Only
Wooanr Uiy, Shadi 1245 Hon-hogetiskle
Serial Number: S0 ' LATE CHICK KO ARBCIUNT
Amount: $933.00 i Fonn
Issuance Payee: Mary Moses e Mary Moses

Mine hundred thirty three and 33 cenis
TF o T Vaid T Vioig '

ISN: 46103803 S DeLaere

HIF2ATALL LS ILEAD 2LEAD=S09L #OD000933334

9. Click the Back button at the top of the screen to return to the Transaction History screen.

< Back —

Payee Review

T Filters
Transaction Information Image
Transaction 1D: 1276012 . .
] a0 Nl
Account Number: oA 580 T Test Capture Only
) Visa Ciy, Saatie 13348 M- Meegonable
Serial Mumber: 9057 } uslE CHEGE B0 ] RO
R R & aaaa

Change Stapus

10. The user is returned to the Transaction History view and may see the following alert message:

In arder to view your changes, please refresh your
browser and review your filbers,
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11. Refresh the browser window to view the changes to the Transaction History screen. The user should see
the previously changed item with the status of Return-User.

y 1276012 sooodBa0 05T $53.36  Return-User 0340472024 m

Notes

1. The Notes feature allows company users to make notes regarding a transaction. Click the Notes button
to enter in the pertinent information regarding the transaction.

]
Transaction [D Account Number Serial Nurmber Credit Delbit Dateli Decision Exception
w  133BE52 OTITT 217486 543271 1242342025 | Pay | Return $
Account Name: SeptalMatters Fayment Date: 12/22/2025 At Notes (0]
Positive Pay Type: payea Loaded Exception Reason: amount Mismatch

Currert Status: Pay-Systam
Tssuance Payes Name: Quentin Quest

[ssuance Sarial Mumber: 217486
Iesuance Armount: $933.00
Issuance Date: 12/22/2025
Driginal Serial Number: 217486

Original Amount: $432.71

2. The Transaction Notes screen will appear. Users can enter notes within this interface, and a log of notes
added to a transaction appears in the lower part of the screen.

Transaction Notes

Client Note Text 1

Save
Created Date Created By MNote
2024-03-04T19:37:09.5490807 FI USER - ldelaereAS1 Transaction Mote 1

Cancel

3. The user can select Save and the transaction will now show the entered Notes. If they can select Cancel to
discard.
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6. MATCH PAID ITEMS

Positive Pay supports the ability for Company Users to match issue items loaded to the system after
cleanup has been performed to paid no issue exception items.

NOTE:

» The Paid No Issue Matching user privilege must be enabled.
> If Reconciliation is enabled and both the issuance and payment date precede the
period start date, matching will not be allowed.

Paid No Issue Match

1. From the Heartland Positive Pay module, click Perform > Paid No Issue Match.

Heartland Positive Pay =~ f¥Manage v | # Perform ~ i Reports ~ = View =

Issue File Load
Manual [ssue Entry
Paid No Issue Match '-] e

Please use the above menu to select an action

2. The Paid No Issue Match screen will display with the current month date range by default. To filter the
date range, click on the Date Range drop-down, select the desired range, and click the Apply button.

: Date Range
Paid No Issue Match N ,
g&March 30, 2022 - April 29, 2022~
Account’
03/30/2022 04/29/2022 Tomarrow
= = Today
< Mar 2022 Apr 2022 ?
festarday

SuU Mo Tu We Th Fr Sa Su Mo Tu We Th Fr Sa

Select Last 7 Days
= 27 28 A 2 3 4 2T 28 29 E 5 1 2
[all | none] Serial Number Payment Date Pai

6 7 8 8 10 H 12 3 4 ToisMant,
Select an account 1 2
3 14 15 16 17 18 19 10 11 12 13 14 15 16  LastMonth

23 24 25 26 A7 18 19 20 21 22 23
{* 1 2 5 A
27 28 29 ﬂ 31 5 24 25 26 27 28 E 30 —

o

o
@
~l
o
w

20 1 22
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3. Inthe portal, the Paid No Issue Match screen must be filtered by Account to display data. Type an
account name or the last 4 digits of the account number to generate the SmartSearch filter.

Paid No Issue Match Date Range

EApril 1,2022 - April 30, 2022~

Account’
testr
Select Account Rows 1-25.
TestRecon - xxxx3579
Lean | e | e e vumes raynem vace Paid Amount Issue Amount Issue Date Issue Type Payee Name

Select an account to search for available transactions to match

4. Once the Account filters has been entered, the screen will display all outstanding issue items that can be

matched to paid no issue items that have previously cleared. The first line in each row will present

information on the outstanding issue item, and subsequent lines will be one or more paid no issue items

that can be matched to the outstanding item.

Paid No Issue Match Date Range

8april 1, 2022 - April 30, 2022~

Account’
clear
Rows 1-110f11.
Select
[all | none] Serial Number Payment Date Paid Amount Issue Amount Issue Date Issue Type  Payee Name

El 113696 04/21/2022 $ 750.00 ] $750.00 04/22/2022 ISSUED ABC Carpentry

(] 113695 $150.00 04/22/2022 I1SSUED Jake Chambers
04/21/2022
04/21/2022

O 113694 $150.00 04/22/2022 ISSUED Mesta Archeron Elain Archeron
04/21/2022
04/21/2022

O 113693 $2800.00 04/22/2022 ISSUED Michael Farrell
04/21/2022 % 2800.00 ®
04/21/2022 % 2800.00 ®

O 113692 $193.93 04/22/2022  ISSUED Cuyahoga County Clerk
04/21/2022 $293.03 &
04/21/2022 $293.03 &

Select [all | none] The user can opt to select individual transactions by clicking the checkbox at the
left of the row. If an issue item has more than one matching incoming transaction,
the radio button for the transaction that the user wants to tie to the issue item must
also be selected.

The company can also select all transactions by clicking “all” in the Select
column. The company can de-select all transactions by clicking “none”.

Serial Number The serial number of the item.
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Paid Amount

Issue Amount
Issue Date

Issue Type

Payee Name

Amount of the paid no issue item.

Clicking the eye icon next to the paid amount will allow the user to view the check

image of the paid no issue item.

The amount of the outstanding issue item.

The date of the outstanding issue item.

Issuance type of the outstanding issue item. Matching can be performed to

Issued, Voided or Stopped unmatched issuance items.

The payee name listed on the outstanding issue item.

5. The user can view check images of the paid no issue items to compare to the outstanding issue item to
determine if the items are indeed a match. Click the eye icon next to the paid amount for any paid item to

view.
Rows 1-130f 13.
Select
[all | none] Serial Number Payment Date Paid Amount Issue Amount Issue Date Issue Type Payee Name
O 113697 $180.00 04/22/2022 ISSUED FedEx
04/21/2022 @ G
04/21/2022 ]

6. A pop-up window with images of the front and back of the check will display. If there is more than one
paid item, examine both check images to confirm if either of them is a match. Click the Close button to

close the check image view.

Check Image

ChmscMomsm o & Testltem  aen o
S e " est Item

‘[ ‘J"_\ui;\n_u\:n‘-.'i:".ylc M it A Check Number 113697 ;
‘our City, State 12345 |

t Date_April 24,2022 i

I 2 |

| H ol

| Sl FedEx :5180.00 |

1 T S e "

| amount _One hundred Sighty and No cents :

I Bellars |

I I

| vemo LON; 44000647 signawre _ 2 DELaCre |

g g S S S g S U U S S U S U R — -

nig2k?eLL e 1357943579r Li3E697 #00000 80004

X9Ware LLC

w0} WO
eI
1euvc; abew)|
e
Aobares abew
L2Ir0rZZ0e
Ao nsodeq 104
vy a0 sogoq

g HOIWLoIEWoNYA|

OT UEMEX
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7. Once a match has been determined to be found, click the checkbox at the left of the row to activate that
row for matching. Click the radio button of the paid no issue item that matched the outstanding issue item.

Single or multiple rows can be activated and selected for matching.

Select
[all | none] Serial Number Payment Date Paid Amount Issue Amount Issue Date Issue Type  Payee Name
113697 $180.00 04/22/2022  ISSUED FedEx
04/21/2022 518000 @
04/21/2022 $18000 @

Match screen to complete the match.

8. Once selections have been made, click the Match Selected button at the bottom of the Paid No Issue

[ Match Selected ]

115686 0472172022 $270.00 L] 526000 04/22/2022 ISSUED Office Pride

O 113685 £600.00 04/22/2022  ISSUED Jonathan Copeland Michael Copeland
04/21/2022 ) ]
0472172022 @

9. The Confirm Matching screen will display. Select Confirm to match any selected Issuance and
Transaction items. Click the Cancel button to cancel without matching

Confirm Matching

Match 2 selected Issuance and Transaction items

Click Cancel to return or Confirm to continue

10. Once Confirm is clicked, a success message will appear.

2 transactions submitted to be matched to issuance
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11. The paid transaction will now show the matched issue item data in Transaction History.

TransactionID  Account Number

54164 XHKX3579

Positive Pay Type: payee

Issuance Payee Name: Office Pride

Serial Number

113686

Credit

i
Debit Current Status Dateli

$270.00  Pay-System 04/21/2022

Payment Date: 04/21/2022

Loaded Exception Reason: Issuance Not Found

Change Status Exception

o

Disposition Created: 04/21/2022 6:00 PM EDT

Issuance Serial Number: 113686
Issuance Amount: $260.00

Issuance Date: 04/22/2022

Original Serial Number: 113686

Original Amount: $270.00

12. Viewing the check data in the Item Lookup interface will show the complete audit history of the

transaction.

Item Lookup

Account’

clear

Account Number: xxxx357

Transaction Date: 04/21/2022
Payment Date: 04/21/2022
Transaction ID: 54164

Debit Amount: $270.00

Current 5tatus: Pay-5ystem

Issuance Date: 04/22/2022
Updated Date/Time: 04/22/2022 12:13 PM EDT

Load Date/Time: 04/22/2022 12:13 PM EDT

Serial Number: 113686

Original Serial Number: 113686
Original Amount: £270.00
Issuance Payee Name: Office Pride
Issuance Serial Number; 113636
Issuance Amount: $260,00

Issuance Status: ISSUED

Update By: sdelaerel
Transaction Id: 54164

Issue Type: ISSUED

View Check Image

Exception Reason: Issuance Not Found
Payee Match Score: Mo payee match needed

Disposition Created: 04/21/2022 6:00 PM EDT

Payee Name: Office Pride
Match Status: PAID

Amount: 5260.00
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7. DECISION DUAL APPROVAL

Positive Pay offers the ability to support dual approval for company decisioning. If enabled for a company,
any transactions in a return status that are decisioned by the company will be held in “suspended” status
until approved or rejected by a secondary user.

NOTE:

» Company Decision Dual Approval permission must be enabled.
» The Decision Dual Approval user privilege must be enabled.

If Decision Dual Approval is enabled, and a Company User has decisioned any transaction in the
Transaction History to the status of User-Pay or has adjusted the serial number or amount of any
transaction, approval will be requested to approve the change of the transaction status. The secondary
company user must approve the transaction decision.

1. Within the Heartland Positive Pay module, click Perform > Transaction Approval.

PRO-CHEX ¥ Manage ~ # Perform ~ Wl Reports ~ View - Change Module ~
Issue File Load

Manual Issue Entry

We | CON[ Transaction Approval Je—

Active Reconciliation
Please use the abg
Statement Balance Entry

Paid No Issue Match
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2. The Check Transaction Approval screen will display.

Check Transaction Approval

Select
[all |

. Account
none]

Number

Xox3579 1327

woo3579 -4

Selected

Current Serial
Number

Requested Serial Current Requested Current RequeszEEd
Number Amount Amount Date Status Statusli Exception
$20.00 03-04- Return- Pay =]
2021 User
$200.00 03-04- Return- Pay @
2021 User

Select [all | none]

Account Number

Current Serial Number

Requested Serial Number

Current Amount
Requested Amount
Date

Current Status
Requested Status

Exception

The company user can opt to select individual transactions by clicking the
checkbox at the left of the row. The company can also select all transactions by
clicking “all” in the Select column. The company can de-select all transactions by
clicking “none”.

Displays the masked account number for the item.

The current serial number of the item. The company user can click the hyperlink in
the serial number to view an image of the check. An eye icon denotes an item
that has no serial number.

The updated serial number, if changed by the company user performing the
decisioning.

Original amount of the transaction.

The updated amount, if changed by the company user performing the decisioning.
Date of the transaction.

Current status of the transaction.

The status of the transaction, if approved.

If the transaction is an exception, an exception identifier will appear in this column.
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3. Clicking the arrow (>) at the far left of each row will expand the view for more pertinent information about
the transaction.

Select
[all |

e Account Current Serial Requested Serial Current Requested Current RequesztEd
+ Number Number Number Amount Amount Date Status Statusi. Exception
v O Xx3579 1327 $20.00 03-04- Return- Pay ]
2021 User

Transaction ID: 31223
Requested By: CEBoots3

Loaded Exception Reason: Mo Issue Item

Transaction ID Unique ID assigned by the Positive Pay system when transactions are loaded
Requested By The company user who has requested the change of transaction status.
Loaded Exception The exception identified when the transaction was loaded.

Reason

4. After examining the transactions pending approval, the company user can select items to approve or
reject by clicking the Approve or Deny buttons at the bottom of the screen.

5. If a transaction is Approved, a Confirm Approval pop-up window will appear. The user can click the
Confirm button to confirm the approval of the transaction status change or click the Cancel button to
return to the Check Transaction Approval Screen.

Confirm Approval

Approve status change of 1 check

Click Cancel to return or Confirm to continue

6. If a transaction is Rejected, a Confirm Rejection pop-up window will appear. The user can click the
Confirm button to confirm the rejection of the transaction status change or click the Cancel button to
return to the Check Transaction Approval Screen.

Confirm Rejection

Reject status change of 1 check

Click Cancel to return or Confirm to continue
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7. Updating Transactions in Pending-Pay Status:

In the case of No Issue transactions that are in Pending-Pay status awaiting approval or rejection, the
user may do the following:

a. Add Issue: A transaction currently in Pending-Pay status can be updated in the Transaction History
page by expanding the view on the transaction and clicking the Add Issue button.

Before changes, the transaction will appear without payee information as shown below.

Select
all
rEonel 1 Account Current Serial Requested Serial Current Requested Current Req UESEEd
Number Number Number Amount Amount Date Status Statush Exception
v O 001111 11605 $54.00 04-19- Return- Pay o
2021 User

Transaction ID: 45615
Requestad By: mfleetwood1

Loaded Exception Reason: No Issue Item

i.  In Transaction History, click the Add Issue button.

v 45615 xox1 111 11605 $54,00  Pending-Pay 04-19-2021 1]

Pasitive Pay Type: payee Return Date: 04/19/2021 15:00:00 EDT Add Issue
Original Serial Mumber: 11605 Return Reason: Amount Incorrect Teller 1D Covey Seminars
Original Amount: $54.00 Loaded Exception Reason: No Issue Item

ii. Complete the Add Issue pop-up screen by entering a Payee Name and clicking the Save button.

Add Issue Item:

Serial Number Amount Payee Name’ Status Issuance Date
11605 54 Henry Fordham ISSUED = 04/16/2021

£

* Account Configured for Recon: To select a date other than today, "X out and add issuance after the Pay request is approved

Save
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iii.  The changes will be reflected in the Transaction Approval screen, as shown below.

Select
all |
rEcne!‘- Account Current Serial Requested Serial Current Requested Current RequeSZtEd
° Number Number Number Amount Amount Date Status Statusli Exception
O 01111 11605 $54.00 04-18- Return- Pay =]
2021 User
Transaction ID: 45615 Issuance Requested
Requested By: mfleetwood1 Requested Issuance Amount: $54.00
Loaded Exception Reason: No Issue Item Requested Issuance Date: 04-16-2021
Requested Issuance Status: ISSUED

b. Items currently in Pending-Pay status will not allow the user to adjust the serial number or amount.

NOTE:

> Itis important to note that if a transaction decision is currently awaiting approval
from a secondary company user and the transaction is not approved or rejected
by EOD, the transaction will revert to its original status. For instance, if a
transaction is set to default return and a company user decisions the item to be
paid, if that decision is not approved by EOD, the item will revert to the default
return status.
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8. USER ACCOUNTS AND PRIVILEGES

Defined in this Section are user privileges and alerting methods supported for the Positive Pay module.

User Privilege Dependencies

Some user privileges are standard, and some are dependent upon features that are enabled by Heartland
Bank. If you see a privilege below and it does not appear, the feature has not been enabled.

Privilege User Feature Dependencies
Approve Issue File Client FI Enabled
Decision Dual Approval Client Fl Enabled
Issue Item Status Report Client FI Enabled
Cancel Issue Item Client FI Enabled
Issue Templates Client FI Enabled
Client Additional Issue Fields Client FI Enabled
Issue Warehouse Client Standard
Transaction History Client Standard
Scheduled Reports Client FI Enabled
Load Issue File Client Standard
Item Lookup Client Standard
Paid No Issue Matching Client Standard
Change Transaction Status Client Standard
Privilege User Feature Dependencies
Pay and Issue Client Fl Enabled
Edit Issue Item Client Standard
Manage Issue File Status Client Standard
View Issue File Status Client Standard
Issue Load Alerts Client FI Enabled
Manual Issue Entry Client Standard
Adjusted Items Report Client Fl Enabled
Reconcile Accounts Client FI Enabled
View Reconciliation Reports Client FI Enabled
DDA Balance Entry Client Fl Enabled




Creating Company Users

NOTE:

» The Company Admin user privilege must be enabled.
» This feature will only display for Company users who have been designated
with Company Admin status.

A Company Admin user can add additional Company users who will then be authorized to use Positive
Pay.

o From the Dashboard > Click Manage Users.

Dashboard 2 Manage Users # Perform ~ i Reports - iE Transaction View Change Module -

The Company Users page appears. Click the “Create New User” button.

 CreateNewUser |[agmed

Please select an existing user or create a new one.

Select User

A Doe, Jane

A Marks, David

User Type

Normal v

o The New User page appears. Fill out all fields available, then click “Create User” button.

Cuthbert Allgood

First Name Last Name
Cuthbert Allgood

Email Address Contact Phone Number Cell Phone Number
cuthberta@finefeathers.com (555) 555-5555 (555) 555-5555|

o The New User interface will display these fields. Please note that the SSO ID field is the
Username which is used to login to Business Connect online banking.
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Judy Dench

Active Admin (Manage other non-admin users)
550D
JDench
First Name Last Name
Judy Dench
Email Address Contact Phone Number Cell Phone Number
jdench@testbank.com (595) 855-4858 (787) 254-1258
o The User profile page appears. Scroll down to the “System Roles” section of the page to select the
roles applicable for the user.
o Within the Positive Pay settings box, the alert method can be chosen. Use the drop-down to
select the alert method desired.
e Email — User will receive Heartland Positive Pay Alerts via Email only
e Email, SMS/TEXT — User will receive Heartland Positive Pay Alerts via Email and
SMS/Text
e SMS/Text — User will receive Heartland Positive Pay Alerts via SMS/Text only
o Choose from the list of available accounts enrolled in Positive Pay the user is entitled to work
with and move them to the Selected Accounts box.
> and < move individual accounts between Available and Selected Accounts.
>> and << move all accounts between Available and Selected Accounts.

Available Accounts Selected Accounts

FFF Escrow (oooedd44) FFFriends (xoooc1111)

FFF Expense (Xxxx3333)

FFF Payroll (omx2222)

=

=

=<

<
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Company User Privileges

NOTE: The Company Admin user privilege must be enabled.

1. On the Company User page, scroll to Positive Pay service station.

2. Choose from the list of available accounts enrolled in Positive Pay the user is entitled to work with and
move them to the Selected Accounts box.

> and < move individual accounts between Available and Selected Accounts.
>> and << move all accounts between Available and Selected Accounts.

Available Accounts Selected Accounts

FFF Escrow (ooodd44) FFFriends (>ooc1111)

FFF Expense (XxxXX3333)

=

FFF Payroll oxx2222) -

3. Selecting Positive Pay User Privileges

a. Selecting all | none
i. By selecting all, the user will be assigned all user privileges.
ii. By selecting none, previously assigned user privileges will be removed.

iii. Clicking in the box beside each user privilege will add or remove the checkmark from the box.
Adding a checkmark will give the user that privilege, removing the checkmark will remove the
privilege from the user.

User Privileges

[&ll | none]
Item Lookup Issue Item Status Report Transaction History
Change Transaction Status Adjusted Items Report Decision Dual Approval
Cancel Issue Item DDA Balance Entry Scheduled Reports
Edit Issue Item Client Additional Issue Fields View Issue File Status
Manage Issue File Status Issue Templates Pay and Adjust
Pay and Issue Reconcile Accounts View Reconciliation Reports
Issue Load Alerts Issue Warehouse Load Issue File
Manual Issue Entry Paid No Issue Matching

4. Select Save User and a Success message will appear.
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9. REPORTS

Issue Item Status Report

NOTE: The Issue Item Status Report user privilege must be enabled.
Reports are available for one (1) year.

1. Within the Heartland Positive Pay Module, click Reports > Issue Item Status.

Change Module =

[1[]]
o
1

PRO-CHEX % Manage~  # Perform~  .liReports ~

Adjusted Items
[ Issue Itemn Status ]4—

Welcome Reconciliation

Scheduled

Please use the above menu to select an action




2. The Issue Item Status Report page appears. The page will default to Outstanding items but can be
changed to Paid items or Returned items.

Issue Item Status

Issue [tem Status

Issuance Status Start Date End Date
_ = to Set = 06/23/2022
@® Qutstanding
Paid [J  Summary Information Only Account’
) Returned
O stops
O Voids
Apply
Issuance Status Outstanding Any items that have not been matched and decisioned yet.
Paid Any items that have been matched and paid.
Returned Any items that have been matched and returned.
Stops Any items that have a stopped status
Voids Any items that have a voided status.
Start Date The start date is only applicable when filtering by Paid or Returned Issuance Status.
End Date The end date will default to the current date.
Summary Information Will show summary, rather than detailed, information on the displayed data.
Only
Account To further narrow down the results the report can be filtered by a specific account.

3. Once search criteria are selected, click Apply to narrow your search results.

4. Search results are displayed in pages of 25 items. If the search contains more than 25 transactions, the
results will be displayed on multiple pages. Use the navigation buttons at the top of the search results to
review all results.

2 trancartinne trtalinn TEEE A5 20
30 transactions totaling $566,415,33

pows 1 - 25 of 30,

- - ’
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5. The Issue ltem Status report will populate below the search window based on filters selected.

a. Filtering for Outstanding Issuance Status:

Account Number

oo 1111
w1111
w0111
w0111
w0111
01111
01111
01111

Serial Number

Payee Name

Citizens Union Bank (v}

Advanced Medical, Inc.

Richard Canava

Waller Lansden Dortch & Davis, LLP

Richard Canava

Office Pride

Jonathan Copeland

Cisco Webex, LLC

Amount

$933.00

51.00

5600.00

$65.55

Issuance Date

05/28/2020

05/28/2020

05/28/2020

05/28/2020

05/28/2020

05/28/2020

05/28/2020

05/28/2020

e Account Number — Displays the masked account number.

e Serial Number — Displays the serial number for the item.

e Payee Name - Displays the payee name, if applicable.

e Amount — Displays the amount of the issuance item.

o Issuance Date — Displays the date of the issuance item.

b. Filtering for Paid Issuance Status:

Account Number

KOX1010

KXXX1010

001010

001010

X0ox1010

wox1010

Serial Number

4113

4112

4110

4109

4108

4107

Payee Name Issuance Amount
ABC Carpentry $750.00
Jake Chambers $150.00
Michael Farrell $2,800.00
Cuyahoga County Clerk $193.93
Covey Seminars $53.36
Citizens Union Bank $6.130.00

Issuance Date

06/23/2022

06/23/2022

06/23/2022

06/23/2022

06/23/2022

06/23/2022

Transaction Amount

Payment Date

$750.00 06/23/2022
$150.00 06/23/2022
$2,800.00 06/23/2022
$193.93 06/23/2022
$153.36 06/23/2022
$8,130.00 06/23/2022

e Account Number — Displays the masked account number.

e Serial Number — Displays the serial number for the item.

e Payee Name - Displays the payee’s name, if applicable.

e Issuance Amount — Displays the amount of the issuance item.

e Issuance Date — Displays the date of the issuance item.

e Transaction Amount — Displays the amount of the presented item.
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c. Filtering for Returned Issuance Status:

Account Number

wox1010

%1010

w1111

XK1

Serial Number Payee Name Issuance Amount

4114 FedEx $180.00

411 Nesta Archeron $150.00
Elain Archeron

113783 ABC 123 $700.00

113782 Jake Jones $150.00

Issuance Date

06/23/2022

06/23/2022

06/06/2022

06/06/2022

Transaction Amount

$180.00

$180.00

$800.00

$260.10

Return Date

06/23/2022

06/23/2022

06/23/2022

06/23/2022

e Account Number — Displays the masked account number.
e Serial Number — Displays the serial number for the item.

e Payee Name - Displays the payee’s name, if applicable.

e Issuance Amount — Displays the amount of the issuance item.

e Issuance Date — Displays the date of the issuance item.

e Transaction Amount — Displays the amount of the presented item.

o Return Date — Displays the return date of the item.

d. Filtering for Stops:

Account Number
¥XMM3333
HHHHIZIZ
¥exx3333

XXMMIZIE

¥XMH3IZFI3

Serial Number Payee Name
306
204
303

302

Issuance Amount

Issuance Date

$306.00 06/16/20
$304.00 06/1
$303.00 06/16/2
$302.00

$301.00

e Account Number — Displays the masked account number.
e Serial Number — Displays the serial number for the item.

e Payee Name - Displays the payee’s name, if applicable.

e Issuance Amount — Displays the amount of the issuance item.

e Issuance Date — Displays the date of the issuance item.
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e. Filtering for Voids:

Account Number Serial Number Payee Name Issuance Amount Issuance Date
XAXX9999 501 $501.00 06/10/2022
WNXBEEE 259 Gwen Lively $60,000.00 06/16/2022
KNXXOE66 258 Gwen Simpson $19.393.00 06/16/2022
WNXBEEE 257 James Brown $280,000.00 06/16/2022
HIXNBE66 287 Jennifer Lopez $225.00 06/09/2022

Account Number — Displays the masked account number.
Serial Number — Displays the serial number for the item.
Payee Name — Displays the payee’s name, if applicable.

Issuance Amount — Displays the amount of the issuance item.

e Issuance Date — Displays the date of the issuance item.
6. Ifthe Summary Information Only checkbox was selected, the Issue Item Status report will populate with
summary information as shown in the graphic below.
Account Number Account Name Check Status Total ltems Total Dollar Amount
w00 117 WHKP Main Qurstanding Issued Items 281 $267,978.96
2222 WEP Payrall QOutstanding Issued Items 17 $9,311.83
003333 WEP Expense Outstanding Issued Items 3 $1,464.75
Grand Total: 5278,755.64

e Account Number — Displays the masked account number.

e Account Name — Displays the name of the account.

e Check Status — Displays the status of the issued items.

e Total Items — Displays the total amount of items with a particular check status for a specific account.

o Total Dollar Amount — Displays the total dollar amount of all items in the row.

e Grand Total — Displays the grand total dollar amount of all items displayed in the rows above.

7. The entire Issue ltem Status Report can be downloaded as a CSV file (Comma Separated Value). Click

on the Download as CSV button at the bottom left of the Issue Item Status Report screen.
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Scheduled Reports

The Scheduled Reports is an Enterprise level feature in Positive Pay designed to provide information related
to outstanding issue items and paid items on a frequency. Scheduled reports can be configured to be
delivered to the financial institution for forward deliver to the Company and/or they can be obtained through
the portal.

Based on the report templates configured for each account, a company user can also choose to generate
interim reports. Interim reports provide the information between the last frequency the report was generated
through the current date the interim report is being generated.

1. To schedule a new report, click the Generate Interim Reports button.

Scheduled Reports i =
=May 23, 2020 - May 29, 2020~
Y Filters >
Rows 1- 8 of 8.
Report Name Report Status Request Type Download Report
¥ CL 3001111 _test-issuance_3023_2020-05-28.csv GENERATED SYSTEM IR
¥  CL3_0mx2222_test-issuance_3022_2020-05-28.csv EMPTY SYSTEM
¥ L 3000111 _test-transaction_3021_2020-05-28.csv GENERATED SYSTEM Dkl
¥ CL3_00m:2222_test-transaction_3020_2020-05-28.csv EMPTY SYSTEM
¥ L300l 111 _test-issuance_2960_2020-05-27.csv DOWNLOADED SYSTEM T
¥ CL3_ 002222 _test-issuance_2959_2020-05-27.csv EMPTY SYSTEM
¥ L 300wl 117 _test-issuance_2899 2020-05-26.c5v GENERATED SYSTEM il
>  CL 3002222 _test-issuance_2898 2020-05-26.csv EMPTY SYSTEM
—

2. The Interim Reports window will appear.

3. Select the appropriate account from the Account drop-down menu.

Interim Reports

Account’ Template’ Start Date End Date

- not selected - v | - Select One - v B | 07/20/2020 B | 07/20/2020

- not selected -
FFF Payroll - xo0m2222
FFFriends - xxex1 111

Generate Report

[ Generate Another




4. Select the desired template from the Template drop-down menu.

Interim Reports

Account’ Template’ Start Date

FFFriends - xoooc1111 W - Select One - v = 07/20/2020

- Select One -
HB1
global template
global issuance

[T Generate Another

End Date

B 072002020

5. Select desired start and end dates for interim reports. Once all fields have been selected, click Generate

Report button. If the user is generating multiple reports, the user can click the Generate Another

checkbox before clicking the Generate Reports button.

Interim Reports

Account’ Template’ Start Date

FFFriends - x0om1111 » global issuance b B | 07/20/2020

e Al Generate Report
=P ] Generate Another

End Date

B | o7/2002020

6. If the user is generating more reports, a success message will appear at the bottom of the Interim

Reports pop-up window, and the window will stay open to add information for another Interim Report.

Once the information for the last Interim Reports has been entered, unselect the Generate Another

checkbox and click Generate Reports to continue.
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Interim Reports

Account’ Template’ Start Date End Date

FFFriends - xoo0¢1111 v global issuance v B | 07/20/2020 B | 07/20/2020

Generate Report

Generate Another

Report Queued for generation successfully

7. The Interim Reports pop-up screen will automatically close, and the Scheduled Reports screen will
display. The Interim Reports requested by the user appear on the Scheduled Reports list.

Scheduled Reports Eaté Range ‘
==july 1, 2020 - July 31, 2020~
Y Filters a
Rows 1 - 25 of 40.

Report Name Report Status Request Type Download Report
»  CLO3 001111 _test-transaction_5614_2020-07-21.csv PROCESSING USER_REQUEST
¥  CLO3 0001111 _test-issuance_5613_2020-07-21.csv EMPTY USER_REQUEST

NOTE:

» Scheduled reports will be generated within the configured report period, even
when an account has no activity for the report period. In these cases, the system
will produce a blank report.
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Reconciliation Reports and Reconciliation Periods

NOTE:

» The Reconcile Accounts user privilege must be enabled.
» The View Reconciliation Reports user privilege must be enabled.

Positive Pay has added the Active Reconcilement function designed for a user to compare the actions taken in
Positive Pay against a company’s internal accounting system and bank account/statement.

Reconciling accounts is a standard and good business practice. It is required to ensure company accounting
records and bank account activity align and which issued checks have been paid and which remain outstanding.
Since Positive Pay is the system of record for housing issued items, performing exception identification, and
accepting pay/return decisions from the company, Positive Pay records should align with the company’s internal
accounting records and the account activity shown in online banking or bank statements.

The company user can access Reconciliation reports or view past and present Reconciliation Period activity.

1. Reconciliation Reports

a. Within the Heartland Positive Pay Module, click Reports > Reconciliation.

PRO-CHEX £} Manage ~ # Perform = oll Reports =

[[[]]
]

Adjusted Items
Issue Itemn Status

We | come | reconciliation le—

Scheduled

Please use the above menu to select an action

b. The Reconciliation Reports page displays.

" Date Range
Reconciliation Reports i
E=july 1, 2020 - July 31, 2020~
Y Filters >
Rows 1-50f5

Report Name Report Status Request Type Download Report
¥»  ACME_ 004321 _test-recon_S605_2020-07-21.csv GENERATED SYSTEM Danlaad
¥ ACME_ %4321 _test-recon_5514_2020-07-20.csv GEMERATED SYSTEM Download
¥ ACME_oood321_test-recon_5436_2020-07-17.csw GEMERATED SYSTEM Dawnload
>  ACME_ »0xx3210_test-recon_5336_2020-07-16.c5v GENERATED SYSTE Ponnload
¥ ACME oooed321_test-recon_5335_2020-07-16.c5v GEMNERATED SYSTEM Download

c. Tofilter the date range of the reports shown, click on the Date Range drop-down.
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e Date Range
Reconciliation Reports o i »
E=july 1, 2020 - July 31, 2020 -
? Filters Tomorrow
-5 of5 Today
Report Name Report Status Request Type Do Yesterday
> ACME_:cowed321_test-recon_5605_2020-07-21.csv GENERATED SYSTEM r Last 7 Days
»  ACME_xoomxd321_test-recon_5514_2020-07-20.csv GENERATED SYSTEM T
Last Month
>  ACME_ 04321 _test-recon_5436_2020-07-17.csv GENERATED SYSTEM [ Chste ange
> ACME_0owe3210_test-recon_5336_2020-07-16.csv GENERATED SYSTEM e

d. To narrow the search results, click Filters and a window containing additional search criteria will

appear. The Reconciliation Reports list can be filtered by Account by entering the first few characters
of the account number or account name to activate the SmartSearch filter.

Reconciliation Reports

Date Range

SEApril 1, 2022 - April 30, 2022+

Y Filters v
Account? Report Status
All

TestR

Select Account

TestRecon - 03579

Reset

Vs 1 - 25 of 125.

e. The results can be further filtered by selecting a Report Status from the Report Status drop-down

menu.
sgas s Date Range
Reconciliation Reports o ‘
EApril 1, 2022 - April 30, 2022~
Y Filters v
Account’ Report Status
clear All i
Downloaded 1
Empty Reset |
Failed > =
Generated -250f 125,
Report Status

Generated - This means that the report was created successfully and that it contains data based on the chosen
report template.

Downloaded - Downloaded means that the report has been downloaded by a user.
Failed - Failed means that the report did not generate properly.

Empty - Empty means that the report ran, but there was no data to pull into the report for the given time period.

f.  Once search criteria are selected, click Apply to narrow your search results.
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g. Reconciliation Report items are displayed in pages of 25 items. If the report contains more than 25
items, the results will be displayed on multiple pages. Use the navigation buttons at the top of the
report results to view all results.

Rows 1 - 25 of 36,

Report Mame Report Status Request Type Download Report
¥  ACME_woomid321_test-recon_5605_2020-07-21.csv GEMNERATED SYSTEM Download
¥  ACME_ooxd321_test-recon_5514_2020-07-20.csv GEMERATED SYSTEM Dl
>  ACME_xxxx4321_test-recon_5436_2020-07-17.csv GEMNERATED SYSTEM Ths e
Report Name The name of the report file.
Request Type The Request Type indicates whether the report was automatically generated by the

system as part of the schedule setup for the report to run on.

Download Report Button Click to download a copy of the Report in the designated format.

h. Click the arrow (>) button next to the Report name to view more useful detail on each Reconciliation
Report. The information shown in this drop-down is an audit history of all the activity that has
occurred on the Reconciliation Report.

TRt Date Range
Reconciliation Reports 3 ; 2
Bjuly 1, 2020 - July 31, 2020 -
Y Filters >
Rows1-5o0f5
Report Name Report Status Request Type Download Report
W ACME w4327 _test-recon_5605_2020-07-21.c5v DOWNLOADED SYSTEM Download
Generated Date: Tue, 21 Jul 2020 09:13:50 Requested Date: Tue, 21 Jul 2020 0%:13:50
Downloaded Date: Tue, 21 Jul 2020 15:52:03 Requested By: FPHQ_APP
o Generated Date — Date the report was generated.
) Downloaded Date — Date the report was downloaded.
) Requested Date — Date and Time report was requested.

. Requested By — User or system who requested the report.



2. Viewing Reconciliation Periods:

i. Within the Heartland Positive Pay Module, click View > Reconciliation Periods.

PRO-CHEX ¥ Manage ~  # Perform - i Reports = B View = Change Module ~
Issue File Status
Issue Warehouse
WE| CO m e Transaction Histary
Please use the above menu to select an action seminotp
[ Reconciliation Periods ] e
j-  The Reconciliation Report Account Page displays a list of the accounts that have been provisioned
with Account Reconciliation. The user can search by account number or name if a long list of
accounts is displayed. Click the Select button on the appropriate account to proceed.
Select Account
Account # Name
o321 Operating Select <
wo3210 Operating2 Select

k. From the Reconciliation Report page for the specific account, the user can select to view any closed
or active reconciliation period that is displayed in the list. Click Change Account to return to the list of
Accounts or click the Select button to choose a reconciliation period.

« Change Account
Select Reconciliation Period for Account Operating

Start Date End Date Previous Outstanding Status

07/21/2020 07/21/2020 $15,073.58 ACTIVE Select
07/15/2020 07/15/2020 £1,160.00 CLOSED SEleLE
07/16/2020 07/16/2020 $13.551.81 CLOSED — Select
071742020 071772020 $13,526.42 CLOSED Select
07/18/2020 07/20/2020 $14.418.68 CLOSED Select
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The Reconciliation statement for the chosen period will display. An example of the screen view is
provided below. Depending on the type of reconciliation the account is set for, the user may see tabs
at the top of the screen to view Check reconciliation, Deposit reconciliation and/or Statement
reconciliation.

5 :"a"-;E:E"-IZICI
Reconciliation for WKP Main

Check Deposic

Check Summary v
Start Date Erud Diate n S
hiew [EE1 e + $B9,709.36
0O/25/2020 002572020
Pmid Mo [ssues = £E81.25
Pald Stopvohd + 30,00

1B TTT.50 Paid Chedis
Stop Payments

Outstanding Activity Total

+ 56970930 r
Cancelled
Purged Ourstanding - 50,00
Outstanding End Balance
EAE T & Presacus Paid Mo [ssuss Recened - S0.00
3208.485.96
Amaunt MEmatch Adjustment % 30,00
Period Activity Total - $83, 700 36
e n

Serial Number Issued Date Issue Amount Status Date Pakd Amount
5032 $600.00

5033 09/35/2020 526000 OUTSTANDING

5034 O5u2572020 50,00 VOIDED (2502020

5035 09/25/2030 593300 OUTSTANDING

5035 05u25/2020 §24.00  OUTSTANDING

5037 56,130,00 QUTSTANDING

§53.36 OUTSTANDING




10. PREFERENCES

Preferences

1. From within the Dashboard or Heartland Positive Pay Module, click User's Name > Preferences.

PRO-CHEX Manage ~

# Perform ~

diReports » Eview

Change Module - .ch.chr.es -

= Client 3
Welcome -_—
O Logout
Please use the above menu to select an action

2. The Preferences page appears.

Preferences
Default Pages

Default Module

- select -

Default PRO-CHEX Page

- default -

Default Dashboard Page

- default -

Save

3. Default Module gives the User the ability to choose the default landing page.

Preferences
Default Pages
Default Module

- select -

~

PRO-CHEX
Dashboard
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4. Default Heartland Positive Pay Page allows the user to select the default landing page within Heartland
Positive Pay.

Preferences
Default Pages

Default Module

PRO-CHEX s

Default PRO-CHEX Page

- default - V|

Manage / Additional Issue Fields
Manage / Issue Templates
Perform / Issue File Load
Perform / Manual Issue Entry
Reports / Issue Item Status

Reports / Scheduled
View / Issue File Status
View / Issue Warehouse
View / Item Lookup

View / Transaction History

5. Default Dashboard Page allows the user to select the default landing page within the Client Dashboard.

Preferences
Default Pages

Default Module

PRO-CHEX M

Default PRO-CHEX Page

- default - v

Default Dashboard Page

- default - A

Manage Users

Reports / Audit Report
Reports / Notification Delivery Report

Transaction View

6. Once any preferences have been selected, click Save to update the settings.

Preferences

Preferences Saved




11. NOTIFICATION ALERTS

If a cell phone number is entered in the Cell Phone Number field in the user’s setup, the user may receive
SMS/Text Alerts if the user is set up for Heartland Positive Pay.

Please be aware that if a user is set to receive Service Level Alerts, the user will receive a service level alert
for all the company accounts, which may include accounts a user is not assigned to work with.

A 10-digit long code number is used for generating SMS/Text Alerts. The code number which will appear in
any SMS/Text Alerts received will be 12029808159. This number may appear formatted as a regular ten-digit
phone number (1-202-980-8159).

Available Alerts

e End of Day (EOD) Completed - An alert notifying that EOD has been completed and listing the day’s return
count.

e Issuance EOD Completed — If Heartland Bank has enabled the Release Issue Files flag in the portal, issue
files will be held until the issuance file deadline hour. This alert is sent notifying that issuance EOD has been
reached.

e Issuance File Generated — This alert is sent to users when an issue file is generated.

e Issuance Load Failure Alert — This alert is sent to notify that an issue file loaded through the portal has issues
that prevent it from loading successfully. (May be sent via Email or Text)

e Issuance Load Success Alert — This alert is sent to notify that the issue file loaded successfully. (May be sent
via Email or Text)

e Issuance Load with Ineligible Items Alert — This alert is sent to notify that an issue file was loaded with
ineligible items that prevented the file from loading successfully. (May be sent via Email or Text)

e EOD Reminder — This alert is sent to notify that the End of Day is approaching and prompting the user to log
in to decision any exceptions. (May be sent via Email or Text)

e Dual Decision Approval Reminder — Alert sent to inform user that transactions involving dual decision
approval are waiting to be approved or rejected. (May be sent via Email or Text)

e Issuance Dual Approval Reminder Alert — Alert sent to inform user that an issuance file involving dual
approval is waiting to be approved or rejected. (May be sent via Email or Text)

e Service Level Alert — A Service level alert is sent to users to notify that transactions are available to decision.
(May be sent via Email or Text)
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